SUPPLEMENT:

S CORPORATIONS

(1120S)
Drake Tax
User’s Manual

Tax Year 2018

Supplement: S Corporations
(1120S)

Support.DrakeSoftware.com
(828) 524-8020
Copyright

The 2018 Drake Tax User’s Manual Supplement: S Corporations, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2018 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
## Table of Contents

What’s New in Drake Tax for S Corporations ......................................................... 9  
IRS Changes for 2018 .......................................................................................... 9  
Before You Start ................................................................................................. 10  
Updating a Prior-Year Return in Drake Tax ...................................................... 11  
Indicating an S Corporation ............................................................................... 11  
Other Information and Overrides ..................................................................... 11  
Header Information ............................................................................................. 12  
Name and Address .............................................................................................. 12  
Tax Year ............................................................................................................. 13  
Boxes A through I .............................................................................................. 14  
Income and Deductions .................................................................................... 14  
Gross Receipts .................................................................................................. 14  
Cost of Goods Sold (Form 1125-A) .................................................................. 15  
Ordinary Gains and Losses ............................................................................... 15  
Other Income (Loss) ......................................................................................... 15  
Compensation and Wages ............................................................................... 16  
Compensation of Officers (Form 1125-E) ....................................................... 17  
Repairs and Maintenance ................................................................................ 18  
Bad Debts .......................................................................................................... 18  
Rents .................................................................................................................. 18  
Taxes and Licenses .......................................................................................... 19  
Interest ............................................................................................................. 19  
Depreciation .................................................................................................... 19  
Depletion .......................................................................................................... 20  
Advertising ....................................................................................................... 20  
Pension and Profit-Sharing .............................................................................. 20  
Employee Benefits Program .......................................................................... 20  
Other Deductions ........................................................................................... 21  
Tax and Payments .......................................................................................... 21  
Net Passive Income ......................................................................................... 21  
Schedule D ........................................................................................................ 21  
Estimated Taxes ............................................................................................... 22  
Payments with Extensions ............................................................................... 22  
Tax Paid on Fuels ............................................................................................. 23  
Underpayment of Estimated Tax .................................................................... 23  
Late-Filing Penalty ......................................................................................... 23  
Direct Deposit of Refunds .............................................................................. 23  
International ACH Transactions .................................................................... 24  
Electronic Funds Withdrawal (Direct Debit) .................................................. 24  
Program Defaults and Overrides ................................................................... 24  
Required Information ....................................................................................... 24
Withdrawal from Multiple Accounts .............................................................. 25
Filing an Extension ....................................................................................... 25
Signing the Return ..................................................................................... 26
Amending a Return ..................................................................................... 26
Additional Information ............................................................................. 27
Schedule B ................................................................................................... 27
State-Specific Information ......................................................................... 27
Schedule K: Shareholders’ Pro Rata Share Items........................................ 30
Navigation .................................................................................................. 30
Passing Through QBI Information ............................................................ 32
Denoting Service Trades or Businesses ...................................................... 33
Reporting Section 199A Items ................................................................. 34
Safe Harbor for Rental Properties ............................................................ 34
Aggregation and PBANs ............................................................................ 35
Schedule K - Business Activities Statement ............................................ 37
Schedule K-1 for 1120S (Shareholder Information) .................................... 37
Officer and Shareholder Data Entry ......................................................... 37
Sorting and Viewing Schedules K-1 .......................................................... 39
Ownership Changes .................................................................................. 40
IRS K-1 Codes ........................................................................................... 40
Multiple Shareholders ............................................................................... 41
Override Fields .......................................................................................... 41
Foreign Addresses .................................................................................... 41
K-1 Export .................................................................................................. 42
K-1 Import .................................................................................................. 42
Supplemental Info. .................................................................................... 42
Domestic Production Activities ................................................................. 43
K-1 Cover Letters ....................................................................................... 43
Shareholder’s Adjusted Basis Worksheet .................................................. 45
Schedule L: Balance Sheet Per Books ....................................................... 46
Schedules L and M-2 ................................................................................... 46
Force-Printing Final End-of-Year Totals ................................................... 47
Flow of Information ................................................................................... 47
The SCH2 Screen ...................................................................................... 47
Autobalance ................................................................................................. 48
Schedules M-1, M-3 (Reconciliation of Books/Return) ................................. 49
Schedule M-1 ............................................................................................. 49
Schedule M-3 ............................................................................................. 50
Schedule M-2 (Analysis of Accounts) ....................................................... 51
Entering Distributions ............................................................................... 51
Column A, Accumulated Adjustments Account ....................................... 51
Column B, Other Adjustments Account .................................................... 53
Column C, Undistributed Taxable Income Previously Taxed .................... 53
Rental Activities ....................................................................................... 53
Line 14, Depreciation ............................................................................... 53
Line 15, Other Expenses (list) .................................................................... 54

WHAT’S NEW IN DRAKE TAX FOR S CORPORATIONS

Drake Tax is programmed to conform to the latest IRS rules and regulations. The 2018 program reflects all changes to forms, credits, and deductions. For details on the new regulations for the 2018 tax year, see the IRS instructions for Form 1120S.

IRS CHANGES FOR 2018

• There are now special rules for eligible gains invested in Qualified Opportunity Funds. Effective December 22, 2017, section 1400Z-2 provides shareholders investing eligible gains in Qualified Opportunity Funds (QOF) tax-favored investments. In Drake Tax, screen 8996 has been added for completing Form 8996, Qualified Opportunity Fund. Screen 8996 is available from the Other Forms tab of the
Data Entry Menu or through a link on line 15 of screen B. See Form 8996 and its related instructions for more information.

- Because many “entertainment” expenses are no longer deductible, screen DED now includes two new lines, one for any deductible entertainment expenses and one for nondeductible entertainment expenses. Meals are still 50% deductible.

- For tax years beginning after 2017, individuals, estates, and trusts may be entitled to a deduction of up to 20 percent of their Qualified Business Income (QBI) from a trade or business, including income from a pass-through entity, plus 20 percent of qualified real estate investment trust (REIT) dividends and qualified publicly traded partnership (PTP) income. The deduction is subject to multiple limitations such as the type of trade or business, the taxpayer’s taxable income, the amount of W-2 wages paid with respect to the trade or business, and the unadjusted basis immediately after acquisition of qualified property held by the trade or business. The deduction can be taken in addition to the standard or itemized deductions. See “Passing Through QBI Information” on page 32 for more details.

- Effective for tax years beginning after 2017, the eligibility of small business taxpayers to use the cash method has been expanded.

- The Domestic Production Activities Deduction (DPAD) has been repealed for tax years beginning after 2017, with limited exceptions. See “Domestic Production Activities” on page 43.

- Section 951A requires U.S. shareholders of controlled foreign corporations to determine and include their Global Intangible Low-Taxed Income (GILTI) in taxable income every year. Section 951A is effective for tax years of foreign corporations beginning after 2017, and tax years of U.S. shareholders in which or with which such tax years of foreign corporations end. In Drake Tax, use the 8992 screen, available on the Foreign tab of the Data Entry Menu.

- Section 965 of the Code (section 965) was amended by section 14103 of the Tax Cuts and Jobs Act (TCJA) requiring certain taxpayers to include in income an amount based on the accumulated post-1986 deferred foreign income of certain foreign corporations of which they are U.S. shareholders, either directly or indirectly through other entities. This is reported on Form 965, Inclusion of Deferred Foreign Income Upon Transition to Participation Exemption System. In Drake Tax, use the 965 screen, available on the Foreign tab of the Data Entry Menu.

- The filing addresses for businesses located in certain states have changed. See item C, “Where to Mail Return” on the FAQ screen.

- For tax years beginning in 2018, every taxpayer who deducts business interest is required to file Form 8990, Limitation on Business Interest Expense Under Section 163(j), unless an exception for filing is met. Click the 8990 link on the Other Forms tab of the Data Entry Menu.

- Schedule M-2 now includes an “Accumulated Earnings and Profits” (AE&P) column for tracking distributions from a corporation that was a C corporation or engaged in a tax-free reorganization with a C corporation.

- New Family Medical Act credit is available in all Drake Tax packages, using new Form 8994, Employer Credit for Paid Family and Medical Leave. Click the 8994 link on the Credits tab of the Data Entry Menu.
**BEFORE YOU START**

Actions you might need to take before starting an 1120S return in Drake Tax include:
- Updating a prior-year return (if you prepared the tax return last year)
- Electing as an S corporation (if the corporation was not an S corporation last year)

**UPDATING A PRIOR-YEAR RETURN IN DRAKE TAX**

A prior-year return can be updated in three ways:
- As a single return (updated one at a time) using Last Year Data > Update Clients 2017 to 2018 (recommended)
- When you open the return for the first time in the 2018 program and are prompted to update it
- With all other returns in the program at once using Last Year Data > Update Clients 2017 to 2018 (not recommended)

**INDICATING AN S CORPORATION**

If the corporation is electing as an S corporation for the first time, it is necessary to indicate this in the program.

On screen 1 in the General Information section, line A, enter the date of election as an S corporation. On line E, enter the date incorporated. On line G, mark the check box, “First year as an S corporation.”

Form 2553, Election by a Small Business Corporation, is required if the entity is making the election with the return. In Drake Tax, use screen 2553, accessible by clicking the Form 2553 link on screen 1 or from the Other Forms tab of the Data Entry Menu.

**NOTE**

If attaching a signed Form 2553 to the return as a PDF, mark the Attaching Form 2553 as a PDF document box on screen 1. If not sent as a PDF, the form must be mailed separately to the IRS before filing the tax return. See Form 2553 instructions at irs.gov.

**Changing File Type**

To change a “C” corporation to an S corporation (1120 to 1120S) within Drake Tax:
1. From the Home window, go to Tools > File Maintenance > Change File Type to open the Convert Client Data File Type window.
2. Enter the EIN of the corporation.
3. Click Continue.
4. Select the new return type (Sub-S Corp 1120S).
5. Click Continue to save changes.
6. Click OK. (Click Exit to leave the Convert Client Data File Type window without making changes.)

**OTHER INFORMATION AND OVERRIDEs**

Use screen 1 to enter the following additional information:
• **Resident State** — If the corporation has a mailing address in one state but does business in another, select the state in which the corporation does business from the Resident State drop list. (When certain states (DE, IN, KY, MI, MO, NY, OH, PA) are selected from the Resident state drop list, the Resident City drop list is activated. Select a city to prepare the appropriate city tax return. If the Resident City drop list is inactive, a city return is either not required or not available.)

• **Miscellaneous Codes and Overrides** — The Other Information section of screen 1 includes fields for miscellaneous codes, invoice numbers, and several override fields. See “Listing a Different Firm, Preparer, or ERO on a Return” and “Customized Drop Lists” in Chapter 2 of the 2018 Drake Tax User’s Manual.

---

**HEADER INFORMATION**

Screen 1 contains fields for the general information that is printed in the top section of page 1 of Form 1120S.

**NAME AND ADDRESS**

Use screen 1 to complete the corporation name and address section of Form 1120S. For state purposes only, if the corporation has an alternate address (such as a P.O. box), you can enter that address on screen 2, in the Address Line 2 field at the bottom of the window. (Access screen 2 by clicking the State Info link on screen 1. (You can also access screen 2 from the States tab of the Data Entry Menu, or by entering 2 in the selector field and pressing ENTER.)

**“Doing Business As”**

(Optional) Anything typed into the DBA field in the Name and Address section of screen 1 will be printed below the legal name of the corporation in the “Name” section of the main form (and on certain other forms, such as Schedule K-1).

Use of the DBA field is optional and data entered there is not required by the IRS. It is provided in the program for the return preparer’s convenience.

**Continuation Line**

The DBA field on screen 1 can also serve as a “continuation” line for entity names that are too long to fit into the legal name field. Be aware, however, that not all federal forms will accept data from a continuation (or DBA) line. For those forms, only the data entered in the legal name field will be used.

---

**NOTE**

Not all states recognize the use of a DBA. Those state packages ignore data entered in the DBA field.

**“In Care Of”**

(Optional) Indicate the person or entity to whom all information should be addressed, if not to the corporation in general. A name entered in the In care of field on screen 1 will be printed above the corporation’s name on in the “Name” section at the top of page 1 of Form 1120S.

This information is not required by the IRS, but is provided in the program for your convenience. It should be used for federal returns and for state returns where applicable.
Do not enter the legal name of the corporation in this field.

**TAX YEAR**

The program uses the calendar year as the default period for all corporation returns; no date entries are required on screen 1 for a December 31 tax year end.

- The program adjusts calculations for depreciation and for gains and losses on sales of assets based on the entity’s tax year.
- For information on filing with a 52-53–week year, see “Electing a 52-53–Week Year (Initial Return)” on page 60.

**NOTES**

**Fiscal and Calendar Years**

If the S corporation uses a fiscal year (where the year begins in the current calendar year and ends in the next), specify the beginning and ending dates in the If not calendar year section of screen 1.

**Short-Year Returns**

A corporation may have to file a short-year return if the entity is changing accounting periods with IRS approval (Form 3115), or if this is its first or last year in business and the tax year is not a full year.

Short-year return election information and 52-53-week tax year election information is entered on the YEAR screen, available from a Year link on screen 1 or on the Miscellaneous tab of the Data Entry Menu. (Certain other elections are made using the ELEC screen.)

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year begins and Fiscal year ends fields, even if the firm uses the calendar year for full-year returns. (These dates appear on the top of the federal form.)
2. Click the Year link to open the YEAR screen.
3. Make your short-year selection from the Other short-year election reason drop list. Your explanation will be displayed at the top of the first page of the tax return. If you do not select an explanation, an EF Message is generated with the return and the return cannot be e-filed.
4. If you selected “General Explanation” from the Other short-year reason drop list, type details of the reasons for filing a short-year return in the Explanation text box.

For more information on short-year explanations, see IRS Pub. 4163.

The program may not correctly calculate depreciation, gains, or losses for a short-year return. Depreciation for a short-year return can be entered on screen 4562 and screens 6, 7, 8, and 9.

**NOTES**

**First-Year Returns**

An S corporation filing a first-year return must use the fiscal year fields in the If not calendar year section of screen 1 if the date of election as an S corporation occurs after the start of the tax year—that is, if the date entered on line A of the General Information section of screen 1 comes after January 1, 2018.

In the Fiscal year begins field, enter the date of election as an S corporation. In the Fiscal year ends field, enter the end of the calendar year (or the end of the fiscal year if not using a calendar year).
**Boxes A through I**

Enter most information for boxes A through I (top of Form 1120S) on screen 1. Note that boxes C (“M-3 attached”) and F (“Total assets”) are completed automatically by the program based on data entered elsewhere. Other boxes are:

- Box A — S election effective date
- Box B — Business activity code (From screen 1, choose a code from the line B drop list, or click in the line B field and press CTRL+SHIFT+S to search for a code.)
- Box D — Employer Identification Number (EIN)
- Box E — Date incorporated
- Item G — Indicates first year as S corporation and inclusion of Form 2553 with return
- Item H — Check boxes for final return, name change, address change, amended return, and S election termination or revocation
- Item I — Number of shareholders during the year (completed automatically based on the number of K-1s; number can be overridden on line I of screen 1.)

---

**Notes**

Enter accounting method at the bottom of screen 1.

The **Client information** fields at the bottom of screen 1 are for reports only and not included in the e-file record.

**Income and Deductions**

Income and deductions are entered primarily on the **INC (Income)** and **DED (Deductions)** screens.

**Gross Receipts**

Enter gross receipts or sales (Form 1120S, line 1a) and returns and allowances (line 1b) on the **INC** screen.

The program calculates gross receipts or sales after returns and allowances based on gross receipts, sales, and any direct entry on line 1b.

---

**Note**

The IRS does not require a detail (CTRL+W) worksheet for gross receipts; therefore, if you are using the trial balance import feature, do not include a detail worksheet for this line—or for any other line that does not require a detail worksheet. For more on the trial balance worksheet, see “Importing Trial Balance Information” on page 67.
**COST OF GOODS SOLD (FORM 1125-A)**

For cost of goods sold (COGS), complete screen A (Form 1125-A, Cost of Goods Sold).

**NOTE**

For more information on completing lines 9a through 9f of screen A, click in a field and press F1 or consult the IRS instructions.

**Inventory**

Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Schedule L, line 3 (“Inventories”). Note that the Inventories fields on screen L (Assets, Liabilities and Equity) are overrides. Anything entered there overrides the inventory data that flows from screen A.

**Line 5, Other Costs**

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previous lines. In Drake Tax, two fields on screen A are provided for line 5: one for other costs excluding depreciation, and one for depreciation (see figure below).

In the field on the Depreciation line, enter any depreciation that relates to the cost of goods sold (unless the amount is flowing from the 4562 Detail screen with COGS selected from the For drop list).

![Figure of Form 1125-A with fields labeled Non-W-2 labor hired, W-2 wages paid, Additional section 263A costs, Other costs - excluding depreciation, and Depreciation]

Note that the Depreciation field on screen A is an override field; an entry here overrides the calculations from the 4562 screen. Amounts entered in this field automatically adjust the total depreciation flowing to page 1 of Form 1120S.

Entries in the Other costs - excluding depreciation field opens a Detail Worksheet.

**NOTE**

Line 14b on the DED screen, “Depreciation claimed elsewhere on return,” is for Form 4562 depreciation included on screen A and elsewhere on the return. This is an adjustment field. No entry is required in this field as the program makes the adjustment for depreciation claimed elsewhere on the return automatically.

**Importing Trial Balance to Form 1125-A**

If using the trial balance import feature (see “Importing Trial Balance Information” on page 67), enter depreciation amounts directly into the appropriate fields on the trial balance worksheet, not into the “depreciation” fields in data entry. When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A and is calculated accordingly.

**ORDINARY GAINS AND LOSSES**

The amount on line 4 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 1120S flows from Form 4797. Amounts can also flow from screen 4562, but only if...
that screen shows assets sold and property type. Screen 4797 is available from the Assets-Sales-Recapture tab of the Data Entry Menu.

**OTHER INCOME (LOSS)**

Enter all amounts for line 5 of Form 1120S, “Other income (loss),” on the INC screen. INC screen data is displayed on attached statements in View/Print mode.

**NEW FOR 2018**

Certain “extender” credits are no longer available. Because, in certain situations, credit amounts can be carried forward from 2017 to a 2018 return, the screens are still included in the program.

Amounts from the following screens no longer flow to line 5 of Form 1120S:
- 6478 (Form 6478, Biofuel Fuels Credit)
- 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields on the INC screen include:
- Amount of credit for tax on fuels
- Interest income on receivables
- Recoveries of bad debts
- Section 481 adjustments
- State tax refund
- Income from insurance proceeds

To enter income or loss from a partnership, estate, or trust, use screen K1P or K1F. (Click the screen links on the INC screen or access them from the Other Forms tab).

To enter additional sources of income not shown, use the Other Income (itemize) field on the INC screen. (An entry in this field creates a Detail Worksheet.)

**COMPENSATION AND WAGES**

Enter shareholder compensation and employee wages on the DED screen. Drake Tax has two fields each for officer compensation and employee salaries/wages: one for non-shareholders, and one for shareholders.

The Salaries and wages to non-shareholders field is an adjustment field. An amount entered here is combined with any amount entered in the Labor hired field on screen F.

The Officer compensation – shareholders and Officer compensation – non-shareholders fields are override fields. Entries in these fields override entries on screens E and K1.

**NOTES**

A credit adjustment is made for the following forms:
- Form 5884, Work Opportunity Credit
- Form 8844, Empowerment Zone and Renewal Community Employment Credit
- Form 8845, Indian Employment Credit
• 8994. Credit for Paid Family and Medical Leave
• 8932, Credit for Employer Differential Wage Payment

The adjustment is indicated on Form 1120S with the “Wks Sal/Wage” literal (Figure 1-1). Actual adjustments are shown on the “Wks Sal/Wage” worksheet in View/Print mode.

![Figure 1-1: ATT_SSW literal on Form 1120S](image)

**Compensation of Officers (Form 1125-E)**

Officer information (name, address, ownership percentage, compensation) can be entered on screen E, or, to save yourself data-entry time—for officers who are shareholders—enter the information on the K1 screens as you’re entering shareholders information. Use screen E for entering information on officers who are not shareholders.

For details on entering officer information on screen K1, see “Officer and Shareholder Data Entry” on page 37.

**Officer Information**

Use screen E to enter officer information and compensation amounts for officers who are not shareholders. Press PAGE DOWN to enter additional officers. Screen E totals are calculated and carried to line 7 of Form 1120S.

The total of officer compensation can be entered in the Officer Compensation override field on the DED screen (generally used when Form 1125-E is not required). An entry in that field overrides any calculations from screen E of the 1120S but does not change the calculations on Form 1125-E.

For privacy and security, you can “truncate” (hide certain digits of) SSNs on Form 1125-E by entering only the last four digits of the officers’ SSNs in the ID number field.

To do so, enter the first five digits of the SSN as “0”s (zeros), and then enter the final four digits of the SSN. Press CTRL+F to “force” the program to accept the number.

For example, enter SSN 123-45-6789 as 000–00–6789. Press CTRL+F.
Screen E has two check boxes: Signs return and Books in care of. Mark the applicable box on the screen that identifies the officer who signs the federal or state returns, and the officer who is the contact person for the books.

**NOTE**

If you mark the Signs return check box on screen E, that officer's information flows to the PIN screen automatically, eliminating the need to re-enter that information. You would still have to enter PINs for the ERO and the officer and signature date on the PIN screen for e-file purposes.

Ownership & Participation

The Ownership and Participation fields on screen E are required. (These fields are also required if using screen K1 instead of screen E for officer information. See “Officer and Shareholder Data Entry” on page 37.) Fields are as follows:

- **Total** — Enter the officer’s ownership percentage.
- **Common** — Enter the percentage of common stock owned by the officer.
- **Preferred** — Enter the percentage of preferred stock owned by the officer.
- **Time** — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

**REPAIRS AND MAINTENANCE**

Enter repair and maintenance costs on the DED screen. An amount entered there is combined with the amount, if any, entered in the Repairs and maintenance field on screen F.

**BAD Debts**

Use the Bad debts field on the DED screen to enter the total debts that became worthless in whole or in part during the year, but only to the extent that such debts related to a trade or business activity.

**NOTES**

Enter deductible nonbusiness bad debts as a short-term capital loss on screen 8949 (Sales and Other Disposition of Assets). Cash-method S corporations cannot take a bad debt as a deduction unless the amount was previously included in income.

**RENTS**

Use the DED screen to enter rent paid on business property used for a trade or business activity. If the corporation rented or leased a vehicle, enter the total annual rent or lease expense incurred in the trade or business activity of the entity, and then complete Part V of the 4562 (screens 8 and 9).

**NOTE**

The Rents field is an adjustment field. An amount entered here is combined with the amount, if any, entered in the Rent fields on screen F.
**Taxes and Licenses**

Enter tax and license amounts on the Taxes and License screen (accessed by clicking the Detail link on the DED screen). Amounts are combined and the sum generated on worksheet “Wks Tax/Lic” (available in View/Print mode) and flow to Form 1120S, line 12 (“Taxes and licenses”). Note that credit from Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) should be entered on screen 8846, which is accessible via the Detail link on the DED screen or from the Credits tab of the Data Entry Menu. These amounts also appear on the “Wks Tax/Lic” statement in View/Print mode and is referred to on line 12 with the literal “Wks Tax/Lic” reference (see circle in figure below).

To keep the notification from appearing on line 12 of the return, go to the PRNT screen and select Suppress printing of form and attachment references.

The fields on the line for State/City Income taxes and St/City franchise taxes on the Detail screen are override fields. Amounts entered in these fields override amounts calculated from entries on the ES screen and flow to the “Wks Tax/Lic” worksheet.

State tax amounts (income tax and franchise tax) entered on the ES screen flow to the “Wks Tax/Lic” worksheet. The state tax amount flowing from the ES screen may differ depending on which method of accounting (cash or accrual) is used.

**Interest**

Using the 1120S instruction guidelines, enter interest expense on the DED screen. Note that the Interest expense field is an adjustment field. Any amount entered here is combined with the amount, if any, entered in the Interest fields on screen F.

See the field-level help (click in the Interest expense field and press F1) for more information.

**Depreciation**

Enter depreciation on the 4562 screen. Make a selection from the For drop list to associate the depreciable item with the correct form or activity. Data from the 4562 screens is calculated and it then flows to Form 1120S and to the selected schedules or forms.

For more information on depreciation and the 4562 screen in Drake Tax, see the 2018 Drake Tax User’s Manual.
**Line 14, Depreciation**

Line 14 of Form 1120S is reserved for depreciation that (1) is from Form 4562, and (2) is claimed on Form 1125-A or elsewhere. While data from the 4562 screen flows to this line, the program also provides field 14b on the DED screen specifically for depreciation that is claimed elsewhere.

Both lines 14a and 14b on the DED screen are adjustment fields.

- **Line 14a** — See field-level help for further instructions and information on how this field ties in to Form 4562.
- **Line 14b** — Drake Tax recommends entering depreciation on the 4562 screen, and then selecting COGS from the For drop list at the top of that screen. You can also use screen A (rather than the DED screen) to enter depreciation claimed on Form 1125-A. An entry on screen A adjusts any entry on line 14b of the DED screen and is calculated into the total deductions for page 1 of Form 1120S. If there is an entry on line 14b of the DED screen but not on screen A, only the line 14b amount is calculated into total deductions.

**Depletion**

Enter depletion amounts on the DED screen. If the corporation claims a deduction for timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as a PDF file to e-filed returns. See “The PDF Attachment Process” on page 63.) Do not deduct depletion for oil and gas properties. (Each shareholder should figure depletion on these properties under section 613A(c)(11).)

- Form T, Forest Activities Schedules, is not available in Drake Tax. Visit its.gov to download the form.
- For oil and gas depletion, see “Oil and Gas Depletion Worksheet” on page 36.

**Advertising**

Enter advertising expenses on the DED screen.

**Pension and Profit-Sharing**

Enter pension and profit-sharing expenses on the DED screen. Click inside the field for line 17 and press F1 for information on what expenses to enter. The program reduces the expense based on the credit amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup Costs. Note that the field for line 17 is an adjustment field. An amount entered here adjusts the amount flowing to Form 1120S from Schedule F, line 23.

**Employee Benefits Program**

Enter on line 18 of screen DED the total for fringe benefits paid or incurred on behalf of employees owning 2% or less of the corporation’s stock. Do not include with these amounts anything that is an incidental part of a pension, profit-sharing, etc., plan or amounts reported elsewhere on the return.

Report amounts paid on behalf of more than 2% shareholders on line 7 (“Officer compensation”) or 8 (“Salaries and wages”) of the DED screen. A shareholder is consid-
ered to own more than 2% of the corporation’s stock if that person owns, on any day during the tax year, more than 2% of the outstanding stock of the corporation or stock possessing more than 2% of the combined voting power of all stock of the corporation.

Note that the field for line 18 is an adjustment field. An amount entered in here adjusts the amount flowing to Form 1120S from Schedule F, line 15.

**OTHER DEDUCTIONS**

Enter all other deductions in the “Other deductions (itemize)” field on the **DED** screen. Drake Tax incorporates the total into line 19, “Other deductions,” on Form 1120S.

The following deductions, credits, adjustments, and exclusions also flow to line 19:

- Amortization from Form 4562
- Credit adjustment from Form 8820, Orphan Drug Credit
- Exclusion from Form 8873, Extraterritorial Income Exclusion
- Credit from Form 8941, Credit for Small Employer Health Insurance Premiums
- Credit from Form 6765, Credit for Increased Research Activities
- “Amortization” from screen **K1F**, line 9, code “C”
- “Other expenses” from screen **F**, line 32

**TAX AND PAYMENTS**

Screen 4 has fields for completing the “Tax and Payments” section of Form 1120S. Note that some fields are overrides fields. Press F1 to view more information on a field.

**NET PASSIVE INCOME**

Line 22a, “Excess net passive income or LIFO recapture tax,” could apply to an S corporation if it was formerly a “C” corporation or if it engaged in a tax-free reorganization with a “C” corporation.

To determine if the corporation must pay the tax, complete the worksheet fields on the lower half of screen 4. If completing the IRS worksheet, enter the worksheet results on screen 4. Enter LIFO recapture directly on screen 4.

**NOTE**

To force the line 22a worksheet to be printed, select the applicable box on screen 4.

**SCHEDULE D**

Use screen **8949** (available from the **Asset-Sales-Recapture** tab of the **Data Entry Menu**) to enter capital gains and losses. The net gain from screen 8949 is carried to line 10, “Other income” of Schedule K (unless a “Property type” is selected on screen
8949, then the net gain flows to lines 7 and 8 of Schedule K). Use screen 8949 to enter data for Parts I and II of Schedule D (Form 1120S), Capital Gains and Losses and Built-in Gains. Use the D2 screen for Part III, “Built-in Gains,” of Schedule D (Form 1120S). For information on using screen 8949 and the 8949 import feature in Drake Tax, see “Capital Asset Reporting” and “Form 8949 Imports” in Chapter 5 of the 2018 Drake Tax User’s Manual.

Put in the total from a brokerage statement (Form 1099-B) for short-term transactions for which basis was reported and for which there are no adjustments on line 1a of screen D2; long-term transactions are entered on line 8a.

**Estimated Taxes**

Form 1120S does not have a federal estimated tax voucher. Estimated tax payments are required only in certain situations. An S corporation must make electronic deposits of employment, excise, and corporation income taxes using the Electronic Federal Tax Payments System (EFTPS).

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most states do not allow estimate payments outside of the EFTPS system. View the field help for the e-file check box in the e-file/Electronic Fund Withdrawal section of screen ES for a list of states that allow e-filed payments.</td>
</tr>
</tbody>
</table>

**ES Screen**

The ES screen (available from the Miscellaneous tab or from the ES Screen link on screen 4) provides a place to enter federal and state estimated taxes paid in 2018. If the return was updated in Drake Tax from 2017, this information flows from the 2017 return. Note that this information is overridden by any entry in the Current-year estimated tax payments field on screen 4.

Use the ES screen for 2019 estimated payments. Future-year amounts appear on the “Estimate Summary” worksheet, generated with the return. (You must enter amounts in the “voucher” fields in the Estimate amt column to generate the Estimate Summary worksheet.) To enter the amount to be credited, use the Amount of overpayment to apply to 2019 field. Note that this information is overridden by any entry in the Amount to be credited to next year’s estimated tax field on screen 4.

The ES screen also provides a way to e-file state estimated tax vouchers and payments, which is required in some states. For estimated taxes from multiple states or cities, press PAGE DOWN and go to a new ES screen.

For details on using the ES screen for filing federal estimated taxes and paying state estimated taxes, see “Estimated Taxes” in Chapter 5 of the 2018 Drake Tax User’s Manual.

**Payments with Extensions**

To make a payment with an extension request, enter the amount being paid in the “Amount paid with extension” field at the bottom of the 7004 screen (available from the Other Forms tab or from a link on screen 4). If an extension was previously requested and a payment was made then, enter the amount paid on screen 4, line 23b.

For electronic payments on extensions, the program produces Form 8878-A, the IRS e-file Signature Authorization for Form 7004. See “Filing an Extension” on page 25.
**TAX PAID ON FUELS**

Use screen **4136** (available from the **Credits** tab of the **Data Entry Menu**) to enter information for Form 4136, Credit for Federal Tax Paid on Fuels. Note that this form consists of four pages – pages 1 and 2 (lines 1 through 8f) on the first screen in Drake Tax. Press PAGE DOWN to reach pages 3 and 4 (lines 9 through 16b). Press PAGE UP or PAGE DOWN to toggle back and forth between the screens.

**UNDERPAYMENT OF ESTIMATED TAX**

For underpayment of estimated tax, complete all applicable fields on screen **2220**. (Note that this screen, available from the **Other Forms** tab of the **Data Entry Menu**, also consists of two screens.)

**NOTE**

The program produces the Worksheet for the Underpayment of Estimated Tax by Corporations ("Form 2220 - Calculations" worksheet in View/Print mode) to explain the calculations for the 2220 penalty.

**LATE-FILING PENALTY**

Drake Tax does not calculate a late-filing penalty. You can choose to enter a late-filing penalty on screen **4**, line 24, “Estimated tax penalty.”

**IMPORTANT**

If you enter a late-filing penalty on screen **4**, line 24, then Form 2220, Underpayment of Estimated Tax, will not be included in the e-file transmission.

**DIRECT DEPOSIT OF REFUNDS**

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submitted with an e-filed return in order for a corporation’s refund to be directly deposited. To complete this form in Drake Tax, use the **DD** screen (available from the **General** tab of the **Data Entry Menu**).

![Figure 1-2: Federal section of DD screen (also 8050 screen)](image)

When filling out screen **DD** (Figure 1-2):

- If the federal refund is to go to the account listed, select **Yes** for the **Federal Account** selection; otherwise, select **No**. (If neither is selected, the program uses the default selection – **Yes**.)
• If a state refund is to go to the account listed, select the state abbreviation from the **State/city selection** drop list.

• Enter the name of the financial institution, the routing number (RTN), the account number, and the type of account (**Checking** or **Savings**). (For validation of entries, the RTN, account number, and type of account must be entered twice.)

If receiving refunds from more than one state tax authority, use the **State Account** sections on the **DD** screen to indicate where other state refunds should be deposited.

**INTERNATIONAL ACH TRANSACTIONS**

State taxing agencies have added foreign account questions to their forms to comply with NACHA rules regarding International ACH transactions (IAT); however, processing IAT is not yet supported by any federal or state tax authority. If you were to indicate that the account was outside the U.S., the state tax authority would automatically ignore the account information and either issue a paper-check refund, or contact the corporation requesting the payment of a balance due via check or domestic bank account. If you indicate that an account is located outside of the U.S., Drake Tax generates an EF Message instructing you to choose an account located in the U.S.

For more information, see **Screen Help** on the **DD** screen and **PMT** screen.

**ELECTRONIC FUNDS WITHDRAWAL (DIRECT DEBIT)**

Use the **PMT** screen, accessible from the **General** tab, to indicate that the balance due for an e-filed return should be withdrawn (direct-debited) from an account.

**PROGRAM DEFAULTS AND OVERRIDES**

By default, the program indicates that the entire balance due (the “Amount owed” line of Form 1120S) is to be withdrawn on the return due date. To indicate otherwise, complete the “Requested payment amount” and the “Requested payment date” override fields of the **PMT** screen for the applicable payment.

If the return is e-filed on or before the due date, the requested payment date cannot be later than the due date. If the return is transmitted after the due date, the requested payment date cannot be later than the current date.

**REQUIRED INFORMATION**

A **Withdrawal selection** (item #1 in Figure 1-3 on page 25) is required if the program is to direct federal and state tax authorities to withdraw funds from the taxpayer’s account.
The name of the financial institution, routing number (RTN), account number, and account type are required. As is the case with the DD screen, the RTN, Account number, and Type of account data must be entered twice (item #2 in Figure 1-3).

Finally, the PMT screen must indicate the return to which the payment data applies (item #3 in Figure 1-3). Put a check mark in the box of the applicable return type.

**WITHDRAWAL FROM MULTIPLE ACCOUNTS**

Only one account can be designated for direct debit of funds for payment of federal taxes or state taxes. To have state amounts withdrawn from an account other than the account indicated for federal payments, complete the fields in the State Account sections of the PMT screen.

**NOTE** Neither the federal nor the state balance due can be paid from more than one account.

**FILING AN EXTENSION**

Calendar year returns are due on March 15, 2019. By filing Form 7004, an S corporation can extend the deadline six months to September 16. Fiscal year returns are due on the 15th day of the third month after the end of their tax year. Form 7004 extends the deadline six months.

For electronic payments on extensions, the program produces Form 8878-A, the IRS e-file Signature Authorization for Form 7004.

To file an 1120S extension, use either of the following options:

- Go to the **7004** screen in Drake Tax (available from the **Other Forms** tab of the **Data Entry Menu**) and select **Generate an extension**. Complete any other applicable fields on the screen.
- Go to the **PRNT** screen (available from either the **General** or **Miscellaneous** tabs) and select **Prepare Form 7004 based on screen 1 data**.


**SIGNING THE RETURN**

Electronic PIN signatures are required to e-file returns. All fields on the PIN screen must be completed to e-file a return, including the title and signature (name) of the officer signing the return.

If you mark the Signs return check box either screen K1 or screen E, that officer’s information flows to the PIN screen automatically, eliminating the need to re-enter that information. You would still have to enter PINs for the ERO and the officer and signature date on the PIN screen for e-file purposes.

An 1120S return must be signed and dated by one of the following individuals:

- The corporation’s president, vice president, treasurer, assistant treasurer, or chief accounting officer
- Any other corporation officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required information on the PIN screen. If it is prepared by an employee or officer of the corporation, open screen 1 and select **NONE** in the Firm # and Preparer # fields.

To have the preparer’s name and address information displayed on the printed return:

- If the return preparer and ERO (entered in Setup > ERO) are the same:
  - Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signature box is marked for the preparer.
  - Complete the PIN screen for the return.
- If the return preparer and ERO are not the same:
  - Go to the PRNT screen for the return and complete the field labeled PIN for preparer’s alternative electronic signature. The PIN entered should match the one entered for the preparer in Setup > Preparer(s). (For more information, press F1 in this field.)

**NOTE**

Setup > ERO & Account Information must be completed for e-file. For information on how to complete this setup window, see 2018 Drake Tax User's Manual. See the IRS instructions for further details on signature requirements.

**AMENDING A RETURN**

Amended 1120S can be e-filed using Drake Tax.

When you amend a return in Drake Tax, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6 of the 2018 Drake Tax User’s Manual.

To file an amended 1120S return:

1. Go to screen 1 and select **Amended return** in section H.
2. Make changes as applicable to forms and schedules.
3. Go to the EF screen and mark the Amended 1120S check box on the left side of the screen.
4. Go to screen X (available from the Miscellaneous tab of the Data Entry Menu) and, using a fresh X screen for each line changed in the 1120S, describe and explain the changes. Press PAGE DOWN to open a new X screen.

If amending just the Schedules K-1, go to each applicable K1 screen, select Amended K1, and make needed changes.

**NOTE**

All K-1s are amended when an 1120S return is amended, and the “Amended K-1” box on all Schedules K-1 is marked by default. To override this default, go to the PRNT screen and mark Do NOT check amended box on Sch. K-1.

**ADDITIONAL INFORMATION**

This section covers Schedule B (Other Information), state-specific information, and some program overrides.

**SCHEDULE B**

Enter the accounting method, principal business activity, and product or service on screen 1. This information flows to lines 1 and 2 of Schedule B.

Use screen B (accessible from the General tab of the Data Entry Menu) to answer questions 3 through 15 of Schedule B.

If the answer to question 3 on screen B is “Yes,” complete screen B1 (press PAGE DOWN from screen B). If the S corporation owned, directly, 20% or more, or owned, directly or indirectly, 50% or more of the total stock issued and outstanding of any foreign or domestic corporation, click the B4A Screen link on screen B to enter information about the domestic or foreign corporation owned. (You can enter information for up to 10 corporations per B4A screen; to add more, press CTRL+PAGE DOWN.)

If the S corporation owned, directly, 20% or more, or owned, directly or indirectly, 50% or more in the profit, loss, or capital in any foreign or domestic partnership (including an entity treated as a partnership), or in the beneficial interest in a trust, click the B4B Screen link on screen B to enter information about the domestic partnership owned. (You can enter information for up to 10 partnerships per B4B screen; to add more, press CTRL+PAGE DOWN.)

**STATE-SPECIFIC INFORMATION**

**Resident State**

The program automatically generates a return for the corporation’s resident state. Use screen 2 to enter company information as it should appear on the state return.

**NOTES**

The Company Information fields on screen 2 apply for the resident state only.

Click the screen 2 link from the States tab or enter 2 in the selector field and press ENTER to open screen 2.
Company Information on screen 2 includes the type of return that applies for state purposes (consolidated, composite, controlled group, multi-state) and state-specific dates, numbers for identification, and fields for miscellaneous data as may be required by a state.

Contact Information

If certain contact information required for state purposes is different from that entered on screen 1, use screen 2 for the alternative data for any of the following entities:

- Registered office
- Principal place of business
- “Books in care of” information

Screen 2 also has fields for the name, title, mailing address, email address, ID number, and telephone number of the S corporation’s contact person.

Other States

Data for other states must be entered manually in state data entry. To access state data entry, select the States tab from the Data Entry Menu and choose a state, or enter the two-letter state code in the selector field and press ENTER.

Multi-State Apportionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment screen (Figure 1-4). This screen provides one central location for entering all state apportionment information instead of having to open each needed state’s screen.

In addition to making data entry faster and easier, this feature provides two worksheets: a summary worksheet (“Wks SA-SUM”) that can be used for verifying input, and a reconciliation worksheet (“Wks SA-REC”) that ties the total of the state amounts to the federal return figures. These worksheets are available in View/Print mode.

The individual state apportionment screens will continue to be available next year in Drake ’19, but will be used to override data entered on the APPT screen. No state apportionment-related screens will be updated from 2017 to Drake ’18.
APPT Screens

The APPT screen is opened to the Sales tab. Links at the top of this screen take you to the Payroll, Property, and Additional Property tabs for each state selected (Figure 1-4 on page 29). These screens and their uses are listed in Table 1-1:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Select state; enter sales, returns and allowance, and other income-related information for each selected state</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter salary, wage, commission, and labor amounts for each selected state</td>
</tr>
<tr>
<td>Property</td>
<td>Enter beginning and ending amounts of common apportionment factors; select additional apportionment factors from drop lists</td>
</tr>
<tr>
<td>Additional Property</td>
<td>Select additional apportionment factors from drop lists</td>
</tr>
</tbody>
</table>

You may enter up to four states on one APPT screen. If you need more than four states, press PAGE DOWN for a new APPT screen. The same state can be entered more than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the reconciliation worksheet. Not every item appearing on the federal return may be sub-

NOTE

Mark the Zero Apportionment check box (Figure 1-4) to add a state but not include any apportionment data. This will include the state on the apportionment summary worksheet (“Wks SA-SUM”), available through View/Print mode.

NOTE

The Ending amount entered on the Property and Additional Property screens in Drake ’18 will become the Beginning amount for property on the APPT screen when the client’s return is updated next year in Drake ’19.
ject to multi-state apportionment. When you select OT, the data entered becomes a reconciling adjustment amount to aid in tying to the federal return.

Enter as much or as little detail as the states require. If a state does not require any information to be entered, no information flows to that state’s return.

**SCHEDULE K: SHAREHOLDERS’ PRO RATA SHARE ITEMS**

Screen K, which consists of five “tabbed” screens, can be used to enter data for Schedule K, Shareholders’ Pro Rata Share Items. Note that many K fields are adjustment fields. Press F1 inside a field to see what amounts are adjusted from elsewhere in the program.

**NAVIGATION**

Screen K has separate tabs for data entry of **Income, Deductions, Credits, AMT and Basis**, and **Other Information** (item #1 in Figure 1-5 on page 30). Click the tabs at the top of the K screen or press PAGE UP and PAGE DOWN to navigate among the K screens.

---

Figure 1-5: Screen K is a tabbed screen (item #1)
Each of the tabs includes “Other” items, such as “Other” income, “Other” deductions, “Other” credits (see item #2 in Figure 1-5), allowing a detailed supplemental K-1 statement (Figure 1-6 on page 31).

Information on foreign transactions is entered on a separate KFT screen, accessible from the Foreign tab of the Data Entry Menu or from the Schedule K Foreign Transactions link on the Credits tab of screen K. Through the KFT screen, you can report multiple foreign transactions. (Press PAGE DOWN for a new KFT screen.) Drake Tax generates a “Foreign Transaction Statement,” shown as “WK_FTRS,” (item #1 in Figure 1-7 on page 32), listing all the foreign transactions for an S corporation. A separate “K-1 Foreign Transaction Statement” (“K-1 STM FTR”; item #2 in Figure 1-7 on page 32) is also generated, reporting these foreign transactions for the individual shareholder.
Passing Through QBI Information

For tax years beginning after 2017, individuals, estates, and trusts that are shareholders in an S corporation may be entitled to a deduction of up to 20 percent of their Qualified Business Income (QBI) from a trade or business, plus 20 percent of qualified Real Estate Investment Trust (REIT) dividends and qualified Publicly Traded Partnership (PTP) income. The deduction is subject to multiple limitations (such as the type of trade or business, the taxpayer’s taxable income, the amount of W-2 wages paid with respect to the trade or business, and the unadjusted basis immediately after acquisition of qualified property held by the trade or business) and can be taken in addition to the standard or itemized deductions.

The S corporation itself is not eligible for the QBI deduction; instead, it must pass the necessary information through to its shareholders. The S corporation must attach a statement to its Schedules K-1, separately identifying each trade or business, and using the same box numbers as shown on Schedule K-1, the amount of the following items:

- Wages
- Salaries
- dividends
- W-2 wages

Because charitable contributions are separately stated to the shareholders, there is no “Charitable Contributions” line on the 1120S return. Charitable contribution information belongs instead on Schedule K. Enter charitable contributions on the Deductions tab of screen K, in the line 12a - Charitable Contributions fields. (These are adjustment fields, adjusting entries made elsewhere in the return.) Any contribution limitation is made at the shareholder level.

NOTE

PASSING THROUGH QBI INFORMATION

Because charitable contributions are separately stated to the shareholders, there is no “Charitable Contributions” line on the 1120S return. Charitable contribution information belongs instead on Schedule K. Enter charitable contributions on the Deductions tab of screen K, in the line 12a - Charitable Contributions fields. (These are adjustment fields, adjusting entries made elsewhere in the return.) Any contribution limitation is made at the shareholder level.

NOTE

PASSING THROUGH QBI INFORMATION

Because charitable contributions are separately stated to the shareholders, there is no “Charitable Contributions” line on the 1120S return. Charitable contribution information belongs instead on Schedule K. Enter charitable contributions on the Deductions tab of screen K, in the line 12a - Charitable Contributions fields. (These are adjustment fields, adjusting entries made elsewhere in the return.) Any contribution limitation is made at the shareholder level.

NOTE

PASSING THROUGH QBI INFORMATION

Because charitable contributions are separately stated to the shareholders, there is no “Charitable Contributions” line on the 1120S return. Charitable contribution information belongs instead on Schedule K. Enter charitable contributions on the Deductions tab of screen K, in the line 12a - Charitable Contributions fields. (These are adjustment fields, adjusting entries made elsewhere in the return.) Any contribution limitation is made at the shareholder level.

NOTE

PASSING THROUGH QBI INFORMATION

Because charitable contributions are separately stated to the shareholders, there is no “Charitable Contributions” line on the 1120S return. Charitable contribution information belongs instead on Schedule K. Enter charitable contributions on the Deductions tab of screen K, in the line 12a - Charitable Contributions fields. (These are adjustment fields, adjusting entries made elsewhere in the return.) Any contribution limitation is made at the shareholder level.

NOTE

PASSING THROUGH QBI INFORMATION

Because charitable contributions are separately stated to the shareholders, there is no “Charitable Contributions” line on the 1120S return. Charitable contribution information belongs instead on Schedule K. Enter charitable contributions on the Deductions tab of screen K, in the line 12a - Charitable Contributions fields. (These are adjustment fields, adjusting entries made elsewhere in the return.) Any contribution limitation is made at the shareholder level.
• Section 199A QBI
• Section 199A W-2 wages
• Section 199A UBIA
• Section 1991A Qualified REIT dividends
• Section 1991A Qualified PTP income
• QBI allocable to qualified payments received from the specified cooperative
• Pass-through Domestic Production Activities Deduction (DPAD) under Section 1099A(g) from a specified cooperative

So you can report this information, Drake Tax has included in the 1120S package new **Qualified Business Income (QBI) Deduction** sections on such screens as K, K1P, K1F, 8825, RENT, and F, and added new screens 199A and N199. Drake Tax automatically produces the required statements with each shareholder’s Schedule K-1.

The program automatically calculates relevant QBI information based on data entry. It is important that you review the calculated results and rely on your knowledge of this client’s tax situation. The program assumes that the corporation operates as a single business entity and that all of the income on Form 1120S, line 21, “Ordinary business income (loss),” is Qualified Business Income for purposes of computing QBI deductions. If the amount on line 21 is from more than one trade or business, use screen 199A to allocate QBI, W-2 wages paid, UBIA, REIT dividends, and PTP income among the separate trades or businesses. If any of the amount on line 21 is not QBI, (for example investment income) use screen N199 to report that amount, and the W-2 wages paid, UBIA, REIT dividends, and PTP allocated to that income.

**Note**

**Denoting Service Trades or Businesses**

Specified service trades or businesses are generally excluded from the definition of qualified trade or business. If the corporation is a Specified Service Trade or Business (SSTB), the shareholder could be subject to income limitations mentioned earlier; you must, therefore, mark the box on screen 1 denoting that this S corporation is a “Specified Service Trade or Business,” if appropriate.

A specified service trade or business is any trade or business providing services in the fields of:

- Health
- Actuarial science
- Athletics
- Law
- Performing arts
- Financial services
- Accounting
- Consulting
- Brokerage services

Also considered an SSTB:

• Any other trade or business where the taxpayer receives fees, compensation, or other income for endorsing products or services, for the use of the taxpayer's image, likeness, name, signature, voice, trademark, or any other symbols associ-
ated with the taxpayer’s identity, or for appearing at an event or on radio, television, or another media format

- Investing and investment management
- Trading or dealing in securities, partnership interests, or commodities

**REPORTING SECTION 199A ITEMS**

Report the Section 199A items to be passed through to the shareholders on screen **K**, in the fields at the bottom of the **Other Information** tab (Figure 1-8).

![Figure 1-8: Fields for section 199A item on the Other Information tab of screen K](image)

**Screen Code:** 199A

If reporting Section 199A income, W-2 wages, or unadjusted basis, click the **199A** link to open the **Qualified Business Income Deduction** screen. On that screen, if the corporation operates more than one business, select **1120S** from the **For** drop list; otherwise, select from the **For** drop list the screen (**K1P**, **K1F**, **8825**, **RENT**, or **F**) that this activity pertains to. On each screen **199A**, type in the EIN and name of the business, and be sure to mark the **Treat as a “specified service business,”** where appropriate. Type the Section 199A information in the appropriate fields. To allocate the amounts and activities to the various shareholders, click the **SA** links. If reporting income data from more than one trade or business, press PAGE DOWN to allocate the data among the separate trades or businesses.

**IMPORTANT**

Be sure to read the field helps for all the Section 199A items on the **Qualified Business Income Deduction** screen and on the **Other Information cont’d** tab of screen **K**.

For screens **8825** (Rental Real Estate), **RENT** (Rental Other Than Real Estate), and **F** (Schedule F, Farm Income), select **Yes** or **No** from the **QBI** drop list if this activity is a trade or business. (This is a required field for the 2018 package. Beginning next year, this field will be completed automatically when the return is updated in the 2019 package.)

**SAFE HARBOR FOR RENTAL PROPERTIES**

A rental real estate enterprise can be treated as a trade or business for purposes of section 199A deduction. To qualify for this safe harbor, the enterprise must meet several requirements, among them:
• If 250 or more hours of rental services are performed each year in respect to this enterprise
• If separate books and records are kept for the enterprise
• The taxpayer maintains contemporaneous records

Commercial and residential real estate may not be part of the same enterprise for purposes of meeting this safe harbor.

Open screen 8825 for each rental property. In the Qualified Business Income (QBI) section at the bottom of the screen, select “N” from the This activity is a trade or business drop list. Make a selection from the Meets Section 199A rental “safe harbor” drop list. The program produces the Rental Real Estate Safe Harbor worksheet (QBI SAFE in View/Print mode).

If rental doesn’t qualify for the Safe Harbor, it might still qualify for the 199A deduction.

For complete details, see IRS Notice 2019-07.

NOTES
• If the corporation operates a trade or business which would qualify the shareholder to be eligible for the Qualified Business Income Deduction, the Section 199A codes in box 20 must be included. Be sure to enter all information provided with the Schedule K-1. Although the QBI deduction cannot be claimed on this corporation’s return, the QBI information should be passed through to the shareholders for use on their returns.
• If no Section 199A information is provided in box 20 of the K-1, and the entity operates a trade or business, contact the entity that produced the Schedule K-1.
• If more than one business activity is being reported, leave the fields in the QBI section blank on the K1P or K1F screen, and enter the data on multiple screens K199A. (Click in the 199A link; press PAGE DOWN for each new activity.)
• If only one activity is being reported, complete the fields in the QBI section of the K1P or K1F screen, and if any data was entered on the 199A screen, open that screen and delete (press CTRL+D).

AGGREGATION AND PBANs
On their Individual returns, shareholders have the choice to “aggregate” (or combine) certain businesses into one entity for purposes of computing the Qualified Business Income deduction (QBID). For that to happen, the corporation must tell the shareholders which trades or businesses might qualify to be aggregated. This is done by using the PBAN fields.

Begin on screen 1 of the 1120S program. At the bottom of screen 1 is a field for entering a PBAN ("Potential" Business Aggregation Number).

A PBAN works just like other “grouping” numbers in Drake Tax, such as multiform codes and passive activity numbers. (See “Associating One Screen with Another” in Chapter 3 of the 2018 Drake Tax User’s Manual for more information on using multiform codes).
If this corporation potentially qualifies to be aggregated with any other businesses on this 1120S return, enter a number in the PBAN field on screen 1.

Enter this same number in the PBAN fields of every appropriate screen for each business on this return that potentially could be aggregated — including the 199A screen. (See “Reporting Section 199A Items” on page 34.) In the figure at right (from screen K1P), this trade has been aggregated with others by using PBAN “2.”

Complete screen K1AG (available on the General tab of the Data Entry Menu) for each of the trades or business suggested for aggregation. Enter the proper PBAN and provide an explanation of the factors met that allow the aggregation in accordance with Regulations section 1.199A-4. Use the same PBAN for the K1AG screen as on the other screens of this aggregation.

Multiple trades or businesses can be aggregated into a single trade or business if they meet the following requirements:

- The taxpayer or a group of persons directly or indirectly own 50% or more of each trade or business for a majority of the tax year and all trades or businesses use the same tax year end.
- None of the trades or businesses is a specified service trade or business.
- The trades or business meet at least two of the following factors:
  - They provide products or services that are the same or that are customarily offered together.
  - They share facilities or share significant centralized business elements such as personnel, accounting, legal, manufacturing, purchasing, human resources, or information technology resources.
  - They are operated in coordination with, or reliance upon, one or more of the businesses in the aggregated group.

If any portion of the income or loss calculated on line 21 of Form 1120S is not trade or business income for QBI deduction purposes, open screen 199A (available from the Other Forms tab of the Data Entry Menu), and allocate the portion of the item that should not be included on Schedule K-1, box 20, codes Z-AD.

Multiple Aggregations

It is possible to have more than one distinct aggregation group. To create a second aggregation, use another number in the PBAN fields of the second group. On the K1AG screen, press PAGE DOWN and include a description of the trade or business and an explanation of the factors met that allow the aggregation in accordance with Regulations section 1.199A-4. Use the second PBAN for this group.

Aggregated entities are listed in a statement with shareholders’ Schedules K-1.

Oil and Gas Depletion Worksheet

The DEPL screen is accessible from the Other Forms tab of the Data Entry Menu. Entries on the DEPL screen flow to the shareholders’ Schedule K-1, box 17, item R. Adjustments to this amount can be entered on screen K, on the Other Information tab, line 17d, item R. When you view the return, the “Wks_DEPL” worksheets and
the “K-1 DEPL” worksheets are listed in the forms tree on the left side of the View/Print window.

**Schedule K - Business Activities Statement**

A Business Activities Statement (screen BAS) breaks down an S corporation’s Schedule K items by business activity (Figure 1-9; listed in View/Print mode as “Wks BAW”).

A K-1 statement (“K-1 Wks BAW”) is also provided for the shareholders.

![Figure 1-9: Business Activities Statement](image)

**Schedule K-1 for 1120S (Shareholder Information)**

Use the K1 screen to enter personal information and ownership data for the shareholders for Schedule K-1, Shareholder’s Share of Income, Deductions, Credits, etc.

**Note**

The program calculates percentage of ownership based on the number of shares owned. (This amount can be overridden on line F of the K1 screen, using the Shareholder’s % of stock ownership field; however, this is not recommended.)

**Officer and Shareholder Data Entry**

Enter information on corporation officers who are not shareholders on screen E; for officers who are shareholders, you can save data-entry time by entering the officer’s title, percentage of ownership and participation, and compensation information in the Officer Information section on screen K1. Data entered on the K1 screens flows to Form 1125-E, Officer Information, when Form 1125-E is required. S.

If the shareholder described on a K1 screen is the officer who signs the return for the corporation, mark the Signs Return check box in the Officer Information section. For the officer who keeps the books, mark that box. (See red circle in Figure 1-10.) This officer’s information will not have to be re-entered on the PIN screen. (The ERO
PIN, the “sign’s return” officer’s PIN, and the Signature Date fields must still be completed on the PIN screen to be eligible for e-file.)

Schedule B-1 information can also be entered on the K1 screens.

![Image](image.png)

**Figure 1-10:** New Officer Information and Schedule B-1 fields on the K1 screen

---

**NOTE**  When you update a 2017 S corporation return in Drake Tax 2018, the information on last year's OFF screen flows to the correct K1 screen.

**Entity Name Field**

Item E of the Shareholder Name and Address Information section of the K1 screen has a Name field for shareholders who are individuals, and an Entity name field for shareholders that aren’t individuals (estates, trusts, tax-exempt organizations, etc.). Putting a name in the Entity name field does not automatically change the type of shareholder; to do so, select from the Type drop list.

**Rounding Shareholder**

Mark the check box on screen K1 to select which should be the “rounding” shareholder. That shareholder will be the one who receives any balancing amount on Schedule K-1 when the return is calculated.

If you do not make a selection, the program designates as the rounding shareholder the last shareholder you entered. If you select more than one rounding shareholder, the program generates a Return Note informing you that you’ve chosen more than one and that the first shareholder you entered will be used as the rounding shareholder, and lists all those you have included as rounding shareholders.

The rounding shareholder’s place in any sort will be determined by the same criteria as the other shareholders when you choose a new sort order.
View a return with multiple Schedules K-1 and you will see, in the forms “tree” on the left side of the View/Print window (in Enhanced View), that each shareholder has a “K-1” folder containing federal Schedules K-1 and any other forms and worksheets generated for that shareholder. Scroll down to a state to see similar K-1 folders for each shareholder.

For those who print their K-1 forms from the Sets tab in View/Print mode, click the Sets tab and notice that each shareholder has a separate folder containing all generated federal and state K-1 schedules, forms, and worksheets, making it easier to print everything needed for the shareholders.

Click the PLUS SIGN [+] to expand the folder to see all documents relating to that shareholder. Click the MINUS SIGN [-] to collapse the folder again.

Set Viewing Order

By default, the order in which the shareholders are entered in the program is the order in which they are listed in View/Print mode and on any forms that list all shareholders for an S corporation. You can select the order in which the shareholders appear from the PRNT screen (available from the General tab of the Miscellaneous tab of the Data Entry Menu). From the Sort K1s by drop list, choose from Control number, ID number, First name, Last name, or Shares.

Screen code: PRNT

Choose to sort by first or last name and the shareholders will be listed alphabetically by the name you choose. (Shareholders that are estates, trusts, tax-exempt organizations, or disregarded entities will be listed by the first letter of the first word or name in the Entity name line of screen K1.)

Control Number

The Control number is an optional number the preparer can use to identify and sort Schedules K-1. The number can include up to five digits and decimals are allowed.

Schedules K-1 can be sorted in View/Print mode by the control number from the PRNT screen.

NOTE

Control numbers are direct entry only. Drake Tax does not automatically “increment” the control number. You have to enter a unique number on each shareholder’s K1 screen.

Screen K1 Overrides tab

Click the Overrides tab (Figure 1-11 on page 40) at the top of the K1 screen to access the K-1 override fields.
Ownership Changes

Ownership changes are entered on the OWN screen, which is accessible through the OWN Screen link on line “F” of the K1 screen or from the General tab of the Data Entry Menu. To use the OWN screen:

• Enter the date of ownership change at the top of the screen.
• Select the applicable shareholder from the Shareholder’s ID Number and Name drop list in the Change in Shares section. (The drop list consists of the names and ID numbers entered on the K1 screens and is updated automatically when a new name is entered on a K1 screen.)
• Enter the change in ownership of shares as a positive amount for an increase and a negative amount for a decrease.
• To enter additional ownership changes, press PAGE DOWN.

NOTE

See field-level help for the Change in Shares field and FAQ item “P” in the program for more information on entering ownership-change information.

Printed Data

A Summary of Stock Ownership worksheet (“Wks SOWN”) is generated in View/Print mode, listing all shareholders, the numbers of shares owned, and the beginning and ending numbers of shares—including any changes in ownership. Because a shareholder’s percentage of ownership may change even if the shareholder’s number of stocks owned does not, all shareholders are listed on the worksheet.

Worksheet “Wks OWN” is also generated for each shareholder who has changes in ownership shares.

IRS K-1 Codes

A code sheet can be printed with each Form 1120S K-1 to help the taxpayer interpret the various codes used on Schedule K-1. In Blank Forms (Tools > Blank Forms from the Home window menu bar), this is the “1120SK_1 Page 3” sheet. To have this sheet printed automatically with all K-1 schedules, from the Home window of Drake Tax, go to Setup > Options > Form & Schedule Options tab and mark the Print Page 2
of Schedule K-1... check box, then OK. The codes can also be printed for a specific return by marking the applicable box on the PRNT screen, or by selecting “Schedule K-1 - Codes” from the forms “tree” in View/Print mode.

NEW FOR 2018

Schedule K-1 codes sheets are now displayed in View/Print mode.

The generated Schedule K-1 may include letter codes and asterisks:

• An asterisk with a letter code indicates that multiple items have that code.
• An asterisk at the bottom of a group indicates that there are more items than can fit in the space provided for that group and that a statement is attached, or that the statement is required (as in the case of “other” amounts).

MULTIPLE SHAREHOLDERS

For returns with a large number of shareholders, you have the option to deactivate calculation and printing of the K-1s while working on Form 1120S. This option, which eases the process of reconciling the 1120S, is available from the PRNT screen. Mark the box under K-1 Items to Suppress.

Before you file the return, go back to the PRNT screen, remove this check mark, then calculate the return.

OVERWRITE FIELDS

It is not possible to override the calculations for a single shareholder’ Schedule K-1. To override calculated data, it is necessary to override the calculated amount on all K-1 schedules.

IMPORTANT

Shareholder overrides should not be used for an S corporation except in certain circumstances, such as ownership changes.

FOREIGN ADDRESSES

If the shareholder has a foreign address, enter Province/state, country, postal code information on the Foreign address line of the Shareholder Name and Address Information section (along with the street address and city in the Address and City fields) of screen K1. Do not enter anything in the U.S. State or ZIP fields. Conversely, for a U.S. address, do not enter anything into the foreign address fields.
**NOTE**

The **Foreign** fields are locked when a return is opened. Click in one of the fields to unlock them throughout the return. To relock the unused **Foreign** fields, close and then reopen the return.

---

**K-1 EXPORT**

Take the following steps to export K-1 information from an 1120S return into the **K1S** screen of a 1040 return:

1. Ensure that K-1 data is entered in the 1120S return and that the 1040 return has been created in Drake Tax. (The **K1S** screen in the 1040 does not have to be created beforehand.)
2. In the 1120S return, go to View/Print mode.
3. Click **K1 Export** in the **View/Print** toolbar. If any K-1s are not eligible to be exported, that list appears. Click **Next** to continue; otherwise, the **Export K1s** window is opened, containing a list of K-1s eligible for export.
4. All SSNs in the list are eligible for export. Remove the check mark from the box to the left of any SSNs you do not wish to export.
5. Click **Export**. The K-1 data will be displayed in the 1040 return in the program.

---

**NOTE**

Basis information for individual shareholders should be entered in the 1040 package in Drake Tax; this information cannot be exported from the 1120S package to a 1040 return. Such an import would override limitations and carryovers calculated in the 1040 program.

---

**K-1 IMPORT**

The K-1 Import feature can import K-1 data from partnership or fiduciary returns into the K-1 “source” screens (K1P and K1F) of the 1120S package.

Open the partnership (1065) or fiduciary (1041) return in Drake Tax, view the return, and click the **K-1 Export** button from the **View/Print** toolbar. Follow the steps in “K-1 Export,” above.

An **Additional Entries** tab (figure at left) on the K-1 source screens in the 1120S return offers 40 more fields for entering, importing, and exporting additional K-1 items.

---

**SUPPLEMENTAL INFO**

Two types of supplemental information can be added to Schedules K-1:
• Supplemental data for all K-1s in a return
• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), from the Data Entry Menu, open screen K1G (Global Supplemental Information) and enter the information in the Supplemental Information text box. This information appears on all printed shareholder K-1s.

To add supplemental information to an individual K-1, open a shareholder’s K1 screen and click the blue Supplemental Info link at the top of the window. In the Supplemental Information Statement text box (Figure 1-12), enter information pertinent to this shareholder. When the return is printed, this information appears on only this shareholder’s K-1.

Figure 1-12: In this example, the information entered on the K1S screen appears on only the K-1 of the shareholder with SSN or EIN of 123123123.

**DOMESTIC PRODUCTION ACTIVITIES**

NEW FOR 2018

• The Domestic Production Activities Deduction (DPAD) has been repealed for tax years beginning after 2017, with limited exceptions.

• Beginning in 2018, a taxpayer is eligible for the DPAD on the federal 1120S return only if it is passed through from a fiscal-year corporation with a tax year that began in 2017. If the DPAD is not from a pass-through fiscal-year entity, complete screen 8903 only if it is needed on the state return.

**K-1 COVER LETTERS**

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You can set up the global option to produce K-1 cover letters for all returns containing K-1 schedules, or you can choose the option on a per-return basis.

To have the K-1 cover letters produced automatically with all applicable returns, from the Home window menu bar of Drake Tax, go to Setup > Options. Under the
Optional Documents tab, on the right side of the window, mark the box labeled Include K-1 letter with returns, then click OK.

The K-1 letters are signed by the shareholder selected as “Signs return” on screen K1.

To have some other shareholder sign the return, either:

- Complete the Signature and Title override fields on the PIN screen
- Complete the Name and Title fields at the bottom of the K1L screen (available on the Miscellaneous tab). Entries here override entries on the PIN screen.

If no default has been set to produce K-1 cover letters with all returns, you can take the following steps to generate letters for a single return:

1. Open the return and go to screen K1L (accessible from the Miscellaneous tab of the Data Entry Menu).

2. At the bottom of the screen, enter the name and title of the person who will be signing the K-1 cover letter.

3. (optional) To have the corporation’s name and address appear in the letterhead of the K-1 cover letters, close the return, then, from the Home window menu bar, go to Setup > Communications Editor > Setup > Page Layout and select Use letterhead on letters. The letterhead is derived from information entered on screen 1.

4. (optional) To have your firm’s contact information and logo printed in the letterhead of the K-1 cover letters, on the K1L screen, select Print firm info/logo from the Information on the K-1 coversheet... drop list at the bottom of the screen.

5. (optional) Select Don’t print entity info from the Information on the K-1 coversheet... drop list at the bottom of the K1L screen in order to prevent the corporation’s or firm’s name and address from appearing in the header of the K-1 letter.

Once the required signing information has been entered, a K-1 cover letter will be generated for each shareholder receiving a K-1.

As with other letters provided by the program, you can edit the text to suit your office needs and style.

Review the following sections of the 2018 Drake Tax User’s Manual before making changes to letter templates:

- “Introduction to Letters in Drake Tax” in Chapter 2, “Installation & Setup”
- The “Letter Keywords” section of Appendix B, “Keywords”

To edit the text of the K-1 letter:

1. From the Home window menu bar in Drake Tax, select Setup > Communications Editor. The Client Communications Editor is displayed.
2. From the icons on the toolbar, select Open > S Corporation > Sub S K-1 Cover Letter to view the template of the S corporation K-1 letter.
3. Make any desired changes to the template.
4. Click Save.
For an amended return, the K-1 letter automatically refers to the amended K-1. To edit the letter for an amended K-1, from the Communications Editor toolbar select Open > S Corporation > Sub S K1 Amended and follow steps 3 and 4 of the previous procedure.

**SHAREHOLDER’S ADJUSTED BASIS WORKSHEET**

Basis information for individual shareholders should be entered in the 1040 package in Drake Tax; this information cannot be exported from the 1120S package to a 1040 return. Such an import would override limitations and carryovers calculated in the 1040 program.

Use the Shareholder’s Adjusted Basis Worksheet (**Basis Wks** tab of the **K1** screen) to calculate a shareholder’s new basis after increases and decreases are made during the current year. The basis of S corporation stock is adjusted on an ongoing basis (unlike for a “C” corporation, where stock basis remains constant unless additional stock purchases are made or stock is sold). A shareholder’s beginning basis in S corporation stock is the original capital contribution.

The Shareholder’s Adjusted Basis Worksheet screen is accessible by clicking the **Basis Wks** tab at the top of the **K1** screen for a shareholder (Figure 1-13).

![Figure 1-13: K1 screen tab for accessing the Adjusted Basis Worksheet](image)

**Increases and Decreases**

*Increases* to basis can include additional stock purchases and capital contributions, separately stated income (including tax-exempt income), and depletion in excess of basis of property.

*Decreases* to basis can include distributions of cash or property to shareholders, separately stated losses and deductions, nondeductible corporation expenses, and credit adjustments.

**Annual Update of Shareholder Information**

When the program is updated to the next tax year, the end-of-year basis and shareholder loan amounts are automatically updated to the beginning of the new year. Any loss/deduction carryover is updated to the beginning of the year and its character (ordinary loss, section 179 expense, charitable contributions, etc.,) maintained. The
program also tracks the amount of debt applied to losses and the total amount of loss carryforwards.

**NOTE** If a K1 screen is marked as final, none of the related screens for that shareholder is updated for the next year.

**SCHEDULE L: BALANCE SHEET PER BOOKS**

Schedule L is required if the corporation’s total receipts for the tax year or its total assets at the end of the year are greater than $250,000.

**NOTES**

To force the program to print Schedule L even if not required, mark the **Force-print Schedules L and M-1** box on screen L or on the PRNT screen.

With the Trial Balance Import feature, you might not need to use screen L at all. See “Importing Trial Balance Information” on page 67.

**SCHEDULES L AND M-2**

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 to facilitate reconciliation of the balance sheet (item #1 in Figure 1-14).

![Schedule L - Balance Sheet](image)

*Figure 1-14: Beginning- and End-of-Year totals displayed on L screen (#1); force printing end-of-year totals (#2)*

Note that the totals from the balance sheet’s subsidiary schedules (SCH2 screen) also appear in the **BOY Totals** and **EOY Totals** columns of the L screen. (See “The SCH2 Screen” on page 47 for more on using this screen.)
If you make any changes to the data, recalculate the return (press CTRL+C) for those changes to be displayed on the screen.

To speed up calculation of returns that contain multiple states, open screen 1 and select 0 from the Resident state drop list. Before filing, be sure to return to screen 1, make a selection from the Resident state drop list, and then recalculate.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, the program “zeros out” the EOY Totals column of Schedule L. Mark the check box on screen L (item #2 in Figure 1-14 on page 46) to force those totals to be displayed in the EOY Totals column.

Flow of Information

Many of the entries made elsewhere on the return flow automatically to the generated Schedule L (for example, inventory information from Form 1125-A). Depreciable asset information from the 4562 screen and intangible assets and amortization also flow to Schedule L.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for certain lines on Schedule L. This screen can be used in place of the actual L screen in the program. In other words, if you use this screen for all applicable lines on Schedule L, you do not need to make any entries on the L screen.

When a return is updated from 2017 to 2018, all line selections are carried to the SCH2 screen, with this year’s year-end amounts flowing to the beginning-of-year column in next year’s program.

To access the SCH2 screen from the L screen, click one of the SCH2 Screen links. The SCH2 screen is also available from the General tab of the Data Entry Menu.

To create a statement for a line, select a line from the Line Number drop list of screen SCH2 and enter a description and its corresponding amount. Once the information is entered, press PAGE DOWN to access a new SCH2 screen. If more detail is required than can fit into a Description field, press PAGE DOWN, and on the new SCH2 screen, select the same line number and then add to the description.

The total of all amounts entered on the SCH2 screen appear on the L screen in the BOY Totals and EOY Totals columns. They are also printed on the return as applicable, with references to the corresponding statements.

If a line is required, a statement (labeled “STATEMENT” or “STM” in View/Print mode, depending on your Setup Options) is produced and is e-filed with the return. Note that an e-fileable “STATEMENT” is referenced in Schedule L of the return, as shown in the example of Figure 1-15 on page 48.
Typically, one or more SCH2 detail screens is needed for Schedule L items. If you are using Drake Tax’s trial balance worksheet feature, be aware that data for the SCH2 screens cannot be entered directly into the trial balance worksheet, and it cannot be imported into the data entry. The SCH2 detail screens must be created apart from the trial balance worksheet.

When the return is produced, Schedule L reflects both the amounts imported from the trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 screen amounts.

For more information, see “SCH2 Detail” on page 74.

**AUTOBALANCE**

Autobalance forces Schedule L to balance for both the beginning- and end-of-year amounts. The program adjusts the unappropriated retained earnings amount on Schedule L by the difference between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000, and Liabilities and Capital = $900, the program increases the unappropriated retained earnings by $100.)

The program makes the adjustment due to differences in the balance sheet. These differences can come from amounts entered incorrectly but are usually the result of one of the following causes:

- An asset was deleted from the 4562 screen (Depreciation Detail) instead of being indicated as sold.
- Beginning inventory amounts were adjusted on screen A, or ending inventory amounts were entered incorrectly.
- Amounts were erroneously deleted from or changed on screen L.
To reconcile the differences, it is best to compare the corporation’s beginning and ending balance sheet amounts for the tax year.

To deactivate the autobalance feature for a specific return, go to the PRNT screen and select Turn off autobalance.

**SCHEDULES M-1, M-3 (RECONCILATION OF BOOKS/RETURN)**

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

**SCHEDULE M-1**

Schedule M-1 shows all items of income and expense that are not subject to tax, plus those accounting items that are not income tax items. When required, taxpayers must reconcile book income with taxable income.

Use screen M1 to enter book-to-tax difference for Schedule M-1. Book-to-tax differences are classified as permanent or temporary, and as favorable or unfavorable. Examples of both kinds of differences are shown in Table 1-2.

**Table 1-2: Examples Book-to-Tax Differences for Schedule M-1**

<table>
<thead>
<tr>
<th>Difference</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permanent</td>
<td>Book or tax items that will never be reported for book or tax purposes</td>
<td>- Meals &amp; entertainment limitations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Penalties</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Tax-exempt interest</td>
</tr>
<tr>
<td>Temporary</td>
<td>Items that will be reported for both tax and book purposes, but not during the same tax year</td>
<td>- Depreciation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Gains or losses on the sale of depreciated assets</td>
</tr>
<tr>
<td>Favorable</td>
<td>Items that reduce taxable income</td>
<td>- Instances in which tax depreciation amount is greater than book depreciation amount</td>
</tr>
<tr>
<td>Unfavorable</td>
<td>Items that increase taxable income</td>
<td>- Disallowed meals &amp; entertainment</td>
</tr>
</tbody>
</table>

**Depreciation and Amortization Adjustments**

The program may make an adjustment for book-to-tax depreciation (or amortization) differences. The calculation is done as described in the following steps. (This procedure refers to “depreciation” throughout, but it applies for either depreciation or amortization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated depreciation (line 10b, column a) is subtracted from the “End of Year” accumulated depreciation (line 10b, column c). This is the “book” depreciation amount.
2. This “book” depreciation amount is compared to the “tax” depreciation amount. (The “tax” depreciation amount is calculated from the Forms 4562, including any section 179 amounts.)
3. The difference between the “book” and “tax” depreciation amounts is carried to the appropriate form and line.
• If the “book” depreciation amount is greater than the “tax” depreciation amount, the difference is carried to one of the following locations:
  – Schedule M-1, line 3a
  – Schedule M-3, Part III, line 24 (as a negative amount)
  – Form 8916-A, line 21 (as a negative amount for assets selected on the 4562 detail screen for COGS)

• If the “tax” depreciation amount is greater than the “book” depreciation amount, the difference is carried to one of the following locations:
  – Schedule M-1, line 6a
  – Schedule M-3, Part III, line 24 (as a positive amount)
  – Form 8916-A, line 21 (as a positive amount for assets selected on the 4562 detail screen for COGS)

**SCHEDULE M-3**

Any domestic S corporation or group of corporations that reports on Schedule L total assets at the end of the corporation’s tax year that equal or exceed $50 million must complete and file Schedule M-3 instead of Schedule M-1. If the S corporation is required to file (or voluntarily files) Schedule M-3, it must file Form 1120S and all attachments and schedules, including Schedule M-3.

The Schedule M-3 section of the General tab of the Data Entry Menu provides direct access to the following screens:
- **M3, M32, and M33** — for Parts I, II, and III of the Schedule M-3
- **M3S** — for supplemental statements
- **SCH3** — for subsidiary schedules for Schedule M-3 and Form 8916-A
- **8916** — for Form 8916-A, Supplemental Attachment to Schedule M-3

Certain income, deductions, gains, and losses flow from Form 1120S to Schedule M-3 in the program, but all other M-3 data must be entered manually on the M3 screens.

**NOTE**

Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the U.S. tax return (per Schedule M-3, Part I, line 11) to total income (loss) on Form 1120S, page 3, Schedule K, line 18.

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed information for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 and 8916 screens.

For more information on using this type of screen, see “The SCH2 Screen” on page 47.

**NOTE**

If the corporation’s assets do not equal or exceed $10 million but the corporation wants to voluntarily file Schedule M-3, or if the corporation’s assets do not equal or exceed $50 million but the corporation wishes to file the complete Schedule M-3, go to screen M3 and make a selection from the Force print M-3 drop list. Choose to print just page 1 of Schedule M-3 or the complete M-3.
**Schedule M-2 (Analysis of Accounts)**

**Note**

On an 1120S return (unlike an 1120 return), Schedule M-2 is not a reconciliation of retained earnings.

For an S corporation return, Schedule M-2 is the analysis of the Accumulated Adjustment Account. Schedule M-2 information can be entered on the M2 screen and elsewhere in the program, but most information flows to the M-2 automatically. See “Entering Distributions” on page 51.

Schedule M-2 represents a corporation picture of the income, losses, and distributions to shareholders and tracks tax-free distributions and helps determine if excess distributions might be taxable to shareholders. If a shareholder receives more in distributions than he or she has in basis, the result might be taxable.

**Entering Distributions**

Code Section 6037 states that an S corporation return must report the amount and date of distributions made to each shareholder. Use the DIST screen for reporting date and distribution amounts for Schedule K, line 16d, “Distributions.” In addition to line 16d, the total from the DIST screen may flow to Schedule M-2, line 7 (subject to limitations) and to the Schedules K-1 based on the shareholder’s ownership percentage. Schedule K-1 distribution information is displayed on the “K1_Dist” worksheet produced with the return.

**Note**

The DIST screen is available from the General tab of the Data Entry Menu, or enter DIST in the selector field and press ENTER.

**Column A, Accumulated Adjustments Account**

The “Accumulated adjustments account” column of Schedule M-2 generally reflects the S corporation’s accumulated undistributed net income after 1982. Non-dividend distributions flow to Schedule M-2 from Schedule K, line 16d. An entry in the “Non-dividend distributions” line of the M2 screen adjusts the amount from the K screen (subject to limitations; see balance-sheet examples on the following page). See the field help for column a of line 7 on screen M2 for more details.

Distributions reported on line 7 flow differently from the amount entered on the DIST screen. (See the previous section, “Entering Distributions.”) The distributions are limited following the ordering rules under Reg §1.1368.2.

**Tip**

See Form 1120S instructions for more details and examples.

These rules are for Schedule M-2, column (a):

- **Line 1 balance** — The balance at the beginning of tax year, line 1 is either “0” (zero) or the balance carried forward from line 8 of the previous year. Due to prior-year net losses and reductions, the amount on line 1 can be negative.
- **Changes to AAA** — The Accumulated Adjustments Account (AAA) is increased for ordinary income from page 1, line 21 (line 2) and other additions listed on line 3. The AAA is then decreased for any loss from page 1, line 21 (line 4) and other reductions listed on line 5.

- **Reduction of AAA** — Once these adjustments are made, the AAA is reduced by ordinary distributions on line 7, but not less than “0.” Thus, if the distributions are $20,000, but the net amount on line 6 is $10,000, line 7 is limited to $10,000. If line 6 is a negative number, then line 7 will be “0” (in this example). To allow an amount on this line would take the AAA to a larger negative number. (That is, even more below zero than it really is).

The rules from the preceding chart apply when the net adjustment for lines 2 through 5 is positive. When the net adjustment for lines 2 through 5 is negative, the ordering rules are switched and AAA is decreased by ordinary distributions (but not below zero) before the net negative adjustment for lines 2 through 5.

<table>
<thead>
<tr>
<th>Schedule M-2</th>
<th>Item</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>Balance at beginning of tax year</td>
<td>($11,786)</td>
</tr>
<tr>
<td>Lines 2 &amp; 3</td>
<td>Ordinary income and other additions</td>
<td>$58,440</td>
</tr>
<tr>
<td>Lines 4 &amp; 5</td>
<td>Loss and other reductions</td>
<td>($489)</td>
</tr>
<tr>
<td>Line 6</td>
<td>Combine lines 1-5</td>
<td>$46,165</td>
</tr>
<tr>
<td>Line 7</td>
<td>Distributions (total $60,000)</td>
<td>($46,165)</td>
</tr>
<tr>
<td>Line 8</td>
<td>Balance at end of tax year</td>
<td>$0</td>
</tr>
</tbody>
</table>

The rules from the preceding chart apply when the net adjustment for lines 2 through 5 is positive. When the net adjustment for lines 2 through 5 is negative, the ordering rules are switched and AAA is decreased by ordinary distributions (but not below zero) before the net negative adjustment for lines 2 through 5.

<table>
<thead>
<tr>
<th>Schedule M-2</th>
<th>Item</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>Balance at beginning of tax year</td>
<td>$11,786</td>
</tr>
<tr>
<td>Line 6</td>
<td>Net negative adjustment (lines 2-5)</td>
<td>($57,951)</td>
</tr>
<tr>
<td>Line 7</td>
<td>Distributions (total $60,000)</td>
<td>($11,786)</td>
</tr>
<tr>
<td>Line 8</td>
<td>Balance at end of tax year</td>
<td>($57,951)</td>
</tr>
</tbody>
</table>

**Important Note about the AAA**

A corporation can make distributions greater than the amount on line 6 of the M-2, but those distributions could be taxable for the shareholders. Enter distributions on the DIST screen; this way, the amounts flow automatically to Schedules M-2 and K-1 but are limited based on the rules described previously. (For more information on the DIST screen, see “Entering Distributions” on page 51.)

Line 7 is limited to the lesser of the amount for line 7 or the positive amount from line 6. If line 6 is negative, line 7 is then limited to the positive amount on line 1. If line 1 and line 6 are both negative, line 7 is disallowed on Schedule M-2. Distributions are entered on the DIST screen to be reported to the shareholders, regardless of the
Schedule M-2 limitation. The AAA cannot be negative as a result of distributions, but it can be negative if it arises from losses.

**COLUMN B, OTHER ADJUSTMENTS ACCOUNT**

Use column **b, Other Adjustments Account**, of screen **M2** to enter any amounts you want printed in the corresponding column of the printed return. Officer life insurance and applicable tax-exempt income flow to Schedule M-2, column b (“Other adjustments account”), line 5. All other amounts (such as expenses) must be entered manually on the **M2** screen.

**COLUMN C, UNDISTRIBUTED TAXABLE INCOME PREVIOUSLY TAXED**

The total of column **c** cannot be negative. This column is active in an 1120S only if the entity was ever a “C” corporation (thus having earnings and profit (E&P)) or if it was a pre-1983 S corporation. By design, Drake Tax does not allow negative numbers in column **c**.

If a corporation becomes an S corporation and has net operating losses (NOLs), the NOL is not generated for the return because it cannot be carried to an 1120S (the IRS does not want the NOL to be used by the shareholders to offset income); it either runs out within the years allowable for the NOL by statute or is used if the S corporation terminates its “S” status within those years.

**RENTAL ACTIVITIES**

Income and expenses for rental real estate properties appear on Form 8825, Rental Real Estate Income and Expenses of an S corporation. To make entries in Drake Tax, use the **8825** screen, available from the **Other Forms** tab of the **Data Entry Menu**.

If there are multiple 8825 properties, press PAGE DOWN for a new **8825** screen. Use one screen per rental property. If a return has more than one **8825** screen, the program reports each property’s information on a separate column of the “Properties” section of Form 8825 (up to eight properties can be included on a form). Data from all **8825** screens are transmitted to the IRS when the return is e-filed.

**NOTE**

Special steps are required for using the trial balance worksheet for multiple rentals. See “Rental Expenses” on page 75.

**LINE 14, DEPRECIATION**

If the program is calculating depreciation (entered on the **4562** screen) for the property listed on Form 8825, do not enter the depreciation on the **8825** screen. Depreciation should be entered only if it is figured outside of the Drake Tax program, and then the
net results should be entered on screen 8825. The amount entered on line 14 of screen 8825 is added to the depreciation calculated from the 4562 screens.

**NOTE** Form 4562 is required for assets placed in service during the year.

**Information Flowing to Form 8825**

To indicate that the information should flow to Form 8825, select 8825 from the For drop list on screen 4562 (Figure 1-16). If there are multiple 8825 screens, use the Multi-form code box. Any depreciation information entered on the 4562 screen flows to the correct Form 8825, based on the form and multi-form code selections at the top of the 4562 detail screens.

For information on using the Multi-form code box, see the 2018 Drake Tax User’s Manual.

![Figure 1-16: In this example, the 4562 information flows to the second 8825 screen created.](image)

**IMPORTANT**

When selecting a multi-form code, note that the code should refer to an 8825 screen—not the 8825 form. For example, data from the second 8825 screen will be generated on the first Form 8825. To associate an asset with that information, you would enter 2 for the screen (not 1 for the form) in the Multi-form code box. For more information on Form 8825, see “Viewing Rental Activity Information” on page 55.

**NOTE** Drake Tax produces a Form 4562 for each property on Form 8825.

**LINE 15, OTHER EXPENSES (LIST)**

Enter meals and entertainment (subject to 50% limit) in the appropriate field on line 15 of the 8825 screen. To enter additional other expenses, begin typing into the Additional other expenses field to open a Detail (CTRL+W) Worksheet. Enter descriptions and amounts on this worksheet.

A statement from each 8825 property is printed with the return (Figure 1-17) and is submitted to the IRS when the return is transmitted.
Figure 1-17: Other expenses are listed on Form 8825 and on accompanying statements; in this instance, “STM 8825_01,” “STM 8825_02,” and “STM 8825_03”

Use the K1P screen to enter rental income the S corporation receives on a Schedule K-1. This amount flows to Form 8825, lines 20a. No entry is required on the 8825 screen.

**QUALIFIED BUSINESS INCOME ON SCREEN 8825**

If this rental activity is a trade or a business, select “Yes” from the This activity is a trade or business drop list at the bottom of the 8825 screen. For a possible aggregation of business for the shareholder’s individual return, type an appropriate number in the Potential Business Aggregation Number field. For more information on using these fields, see “Passing Through QBI Information” on page 32 and “Aggregation and PBANs” on page 35.

**VIEWING RENTAL ACTIVITY INFORMATION**

Rental activity data is viewed on the 8825 forms and accompanying statements.

- **8825 Forms** — The two-page Form 8825 can contain information for up to eight rental activities. Each Form 8825 in View/Print mode contains up to eight rental activities. If more are entered, a second Form 8825 is created (see figure at right).

- Form 8825 in View/Print mode consists of one or more pages (depending on the number of rental activities) listing up to four rental activities per page. If more than four rental activities are entered, scroll down to the second page of the Form 8825 when viewing.

- **8825 Statements** — Depending on your selections at Setup > Options, statements are titled STM_8825_XX, where XX equals the instance of the 8825 screen. (For example, the statements for the first and second 8825 screens would be labeled STM_8825_01 and STM_8825_02, respec-
CREDITS AND ADJUSTMENTS

Certain credits require an adjustment to either income or expenses. The required adjustments flow to the appropriate line of the return and to either Schedule M-1 or Schedule M-3.
Manually reducing the expenses or deductions or increasing the income for these credits causes the return to be out of balance.
See “Credit Adjustments” on page 16 for more.

ELECTIONS

The ability to make certain tax elections is included in the business packages. Elections are selected from the Election drop list on the ELEC screen (Figure 1-18).

Figure 1-18: Return Elections portion of ELEC screen

MAKING AN ELECTION IN DRAKE TAX

To indicate that the S corporation is making an election:
1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry Menu or by typing ELEC in the selector field of the Data Entry Menu and pressing ENTER.)
2. Make a selection from the Election drop list (Figure 1-19).
3. Complete all other fields as applicable. Press F1 in any field to learn if a field is required for your selection and the type of information that may be needed. For example, the help text for the **Other date or year-ending** field shows that the field is required only for election options 15, 27, 28, 29, and 31, and it explains what, specifically, should be entered for each of these elections (Figure 1-20 on page 57).

![Figure 1-19: Election drop list](image)

**NOTE**

If the election option you selected is not listed in the help text for a field, then that field should be left blank. For example, if you chose election **01 (General Election Statement)**, you would not need to enter anything into the **Date or year-ending** field (help text in Figure 1-20).

To open a new **ELEC** screen for an additional election, press **PAGE DOWN**.
ELECTION STATEMENTS

Once an election is made and the return is calculated, the election information is produced on a statement referenced as either “STATEMENT” or “Statement ELXX” (where “XX” is the number of the election) depending on your selections in Setup Options. For example, election 01 (General Election Statement) is generated as “Statement EL01” if you select Print only one overflow statement per page at Setup > Options > Calculation & View/Print tab, or in one of the “STATEMENT” pages if you clear the Print only one overflow statement per page check box.

The election statement includes the election title, election wording, and any additional information required for the election, such as a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other times, they are included as separate lines. Signature lines are printed as needed on some statements.

SAFE HARBOR ELECTIONS

Use the Building qualifies for Section 1.263.. check box on screen 4562 to apply a small taxpayer Safe Harbor election to a building listed in the Description field. An election statement (“Election Stmt”) is produced and the building description as entered in the Description field is included in the election statement.

NOTE

This Safe Harbor election covers buildings only.


MAKING CHANGES ON THE FLY

Use the PRNT screen, as described in the following paragraphs, to override program defaults.

SUPPRESSING/FORCING ITEMS

To suppress the printing or production—or to force the printing or production—of certain documents, go to the PRNT screen and select the desired options. Many “on-the-fly” changes override the options established in Setup Options.

1120S Items

These items can be “forced” (forcing the program to generate the item) on a return:

• 1125E Officer Information
• Schedules L and M-1
• Form 4562 (Depreciation and Amortization)
• Next-year depreciation listing
• “Inactive return” printed on first page of the 1120S
• Preparer and officer signature on printed copy of return
The following 1120S items can be “suppressed” (kept from being generated) on a return:

- Schedule M-2
- WK_M2 (Retained Earnings Reconciliation Worksheet)
- Form and worksheet references

**NOTE**

Form and worksheet references are for the benefit of the preparer and client but are not required for the tax return. References appear on tax forms to clarify which worksheets (available in View/Print mode) correspond to which calculations, and which forms/screens certain amounts are carried from.

- Proformas for the next tax year

**K-1 Items**

The following K-1 items can be “forced” (forcing the program to generate the item) on a return:

- Shareholder’s adjusted basis worksheet (Wks SBAS)
- K-1 codes (page 2 of the Schedule K-1)

The following K-1 items can be “suppressed” (kept from being generated) on a return:

- Related documents: Schedule K-1, K-1 cover letter, K1 ATT worksheet (for K-1 statement overflow), and shareholder’s adjusted basis worksheet (Wks SBAS)
- Marking of “Amended K-1” box on printed Schedule K-1
- K-1_DIST worksheet

**OVERRIDING OTHER SETUP OPTIONS**

Filing instructions and envelope coversheets can be either forced or suppressed from the PRNT screen to override the global setting in **Setup > Options > Optional Documents** tab.

The PRNT screen also includes options to disable autobalance (see “Autobalance” on page 48), calculate the Form 2220 penalty, and prepare an extension (Form 7004) based on the data entered on screen 1. (See “Filing an Extension” on page 25.)

**OPTIONAL (BUT RECOMMENDED) SECURITY INFORMATION**

**Screen Code: SEC**

The **Filing Security Information** screen (SEC) in Drake Tax is part of an ongoing IRS initiative to protect the business and tax return preparers from data theft and tax fraud. The information entered on the SEC screen is transmitted when the tax return is e-filed. Completing this screen for federal returns is strictly optional for 2018; however, certain states will begin requiring this information in the near future.

Screen (SEC) is accessible through a link on screen 1 or from the **Data Entry Menu**.
**Electronic Filing**

Steps to e-file Form 1120S are the same as to e-file Form 1040, with the exception of bankruptcy returns, which must be paper-filed.

An S corporation with $10 million or more in total assets that files 250 or more returns a year is required to e-file its Form 1120S returns.

**Notes**

Every 1099, W-2, 940, and 941 form that is filed is counted as part of the 250-return threshold. For example, if a corporation filing an 1120S return also files 150 W-2 forms, each W-2 would count as a separate return within the 250-return threshold.

Calendar year returns are due on March 15, 2019. Fiscal year returns are due on the 15th day of the third month (two and a half months) after the S corporation’s year end. Returns can be e-filed after these dates; however, if an extension has not been filed, penalties and interest are applied.

**EF “ACK” Page**

Similar to federal Form 9325, Acknowledgment and General Information for Taxpayers who File Returns Electronically, generated with 1040 returns, the federal and state business packages generate an “EF ACK” page in View/Print mode for the main forms of federal returns and “(ST)EF ACK” page for the main forms of state returns.

This is a Drake Tax-generated form that serves the same purpose as Form 9325: an acknowledgment that a return has been transmitted through Drake Tax and received by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being processed) or an “R” ack (for a rejected return), the top section of the EF_ACK is completed, noting the name and address of the client, the return type, the ERO who transmitted the return, and a check mark indicating the return was received by the IRS or applicable state agency.

When you download and process your acknowledgments and receive an “A” ack, the second section of the EF ACK is generated, indicating the return was accepted by the IRS or state agency and the date the return was accepted. The submission ID number is also included.

**Additional Return Types**

Short-year returns, 52–53-week year returns, and inactive returns can all be e-filed using Drake Tax. For information on how to indicate a short-year return in Drake Tax, see “Short-Year Returns” on page 13. Information on e-filing 52–53-week returns is provided in the following sections.

**ELECTING A 52–53 WEEK YEAR (INITIAL RETURN)**

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter data on both screen 1 and the Year screen.
To elect a 52-53–week year for any entity:

1. In the **If not calendar year** section of screen 1, enter the **Fiscal year begins** and **Fiscal year ends** dates. Use MMDDYYYY format, as shown in the example in Figure.
2. Mark the **52-53-week tax year** box.

In this example, the fiscal year begins 09/29/2018 and ends 09/27/2019 (the last Friday in September), giving the entity a 53-week year for 2018.

---

**NOTE**

An entity that has filed returns in the past must complete only steps 1 and 2 of this process. An entity that has never filed a return before must continue with steps 3 through 6.

3. Click the **Year** link to open the **Short Year Elections** screen (Figure 1-21 on page 61).

[Figure 1-21: Elections for 52-53-week tax years]

4. For line 1, select the month in which the 52-53–week year ends for the current fiscal year. (01 = January, 02 = February, etc.)
5. For line 2, select the day of the week the tax year always ends.
6. For line 3, enter the actual date that the tax year ends (the same date entered in the **Fiscal year ends** field on screen 1).

---

**NOTE**

Once a 52-53–week year is selected, the corporation must use that accounting period every year. To change accounting periods, the corporation must submit to the IRS Form 3115, Application for Change in Accounting Method.

In subsequent years, only the **52-53–week tax year** check box on screen 1 must be marked; the program automatically updates the dates.

---

**INACTIVE RETURNS**

Entities that are inactive but are still required to file returns may e-file inactive returns in Drake Tax. To indicate that a return is inactive:

1. Go to the **PRNT** screen, accessible from the **General** tab.
2. Under **Items to Print**, mark the **Print inactive return** check box.

When the return is calculated, the program displays the words “Inactive Return” on the main form of the return (specifically, in the box above line 1c). Zeros are displayed
where required by the IRS in order for amounts to be properly included in the e-file data.

**NOTE**

All EF Messages must be cleared in order to e-file an inactive return.

For detailed instructions on e-filing returns in Drake Tax, see *2018 Drake Tax User’s Manual*.

**COMMON REJECT CODES**

If one or more of the following IRS reject codes is generated when e-filing an 1120S return, the preparer must contact the IRS for further information. The IRS e-Help Desk telephone number is (866) 255-0654.

- **Reject Code R0000-900-01** — The return type indicated in the return header must match the return type established with the IRS for this EIN. If you get this reject code, you must contact the IRS to correct its database or paper-file this return.

- **Reject Code R0000-905-01** — Electronic Filing Identification Number (EFIN) in the return header must be listed in the e-file database and in “accepted status.” If you get this reject code, you must update your e-file application to include the 1120S return type. This should be done at the IRS website. Review publication 3112 for details.

- **Reject Code F1120S-239-01** — Filer’s TIN and Name Control in the return header must match data in the e-file database unless Form 1120S, Item H (2), “Name Change” box is marked.

**FORM 5471**

Screens used to complete Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign Corporations, are also found on the Foreign tab of the [Data Entry Menu](#). This form is used by certain U.S. citizens and residents who are officers, directors, or shareholders, or partners in certain foreign corporations.

Taxpayers who must file this form are described in the IRS instructions. Form 5471 will not be e-filed with the 1040 return. File by the due date (including extensions) for that return.

For details on using this form, see the IRS instructions for Form 5471.

**E-FILE FINCEN FORM 114**

When you calculate a return in Drake Tax, any required information missing from screens 114 and FRGN generates EF Messages unique to the FinCEN Form 114 — listed in “FBAR Messages Pg” in View/Print mode. Before the FinCEN Form 114 can be eligible for e-file, all FinCEN 114 EF Messages on the “FBAR Messages Pg” must be cleared (and FinCEN has a green check mark on the Calculation Results window if you have the Pause option selected at Setup > Options > Calculation & View/Print).
In data entry, open screen EF and mark the **FinCEN 114 only** check box. Click View (or press **Ctrl+V**). “FinCEN114” will be indicated on the EF Status page in View/Print mode and “Form 114” is displayed in the forms “tree” and is listed on the bill.

Close the return, and from the Home window toolbar, go to **EF > Select Returns for EF**. “FinCEN 114” will be displayed in the **EF Documents** column of the **EF Return Selector**. EF. “FinCEN 114” will be displayed in the **EF Documents** column of the **EF Return Selector**.

Proceed as you would to e-file any other return in Drake Tax.

- No other returns—state or federal—can be transmitted with the FinCEN Form 114 through Drake Tax.
- Form 114, Report of Foreign Bank and Financial Accounts (FBAR), can be e-filed through Drake Tax in the same way all returns are e-filed through Drake Tax (see *2018 Drake Tax User’s Manual*). This report can also be completed on, and submitted through, the BSA E-Filing System for the Financial Crimes Enforcement Network website at http://bsaefiling.fincen.treas.gov/main.html
- The link to the BSA website is still available on screen 114 for those who prefer that method of filing or who are seeking more information on the BSA E-Filing System for the Financial Crimes Enforcement Network.

**NOTE** The IRS has announced changes to the FinCEN 114 reports for the 2018 tax year, but as of this publication, has not released these changes.

### Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a document must be printed and scanned into the computer (or “saved” as a PDF document), and attached to the return in order to be e-filed with the return.

You can attach PDF files to federal S corporation 1120S returns for e-file. The **PDF Attachments** screen is accessible from the **General** tab of the **Data Entry Menu**.

### The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-file

These steps are described in the following sections.

**Creating a PDF File**

To create a PDF file:
1. Scan the document to be attached to the return.

**Tip**  
It’s a good idea to use the Drake Documents scanning feature for this step.

2. Save the document to your client’s Drake Documents file, your computer’s desktop, or anywhere you can readily find it.

**Note**  
Many types of documents (for instance, documents created in Microsoft Word) can be printed or “saved” as PDF documents if you have a PDF printer (such as Adobe Reader) installed.

---

**Adding PDF Documents**

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake Tax. From the General tab of the Data Entry Menu, click **PDF Attachments** or type **PDF** in the selector field and press ENTER (Figure 1-22 on page 64).

![Image](image.png)

Figure 1-22: Select **PDF Attachments**, or type **PDF** into the selector field and press ENTER

2. Fill out the columns on the **PDF Attachments** screen. See Table 1-3 for examples.

**Table 1-3: PDF Attachment Window Columns**

<table>
<thead>
<tr>
<th>Name of Column</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Source</td>
<td>Name or number of regulation, publication, or form instruction that makes attachments necessary</td>
<td>- IRS Pub xxx-1.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Form Instructions for 1120S</td>
</tr>
<tr>
<td>Description</td>
<td>Description of form or document to be attached</td>
<td>- Title of house on Oak Street</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Appraisal of Lot 1234</td>
</tr>
<tr>
<td>File name</td>
<td>Distinctive, easily recognizable file name, followed by “.pdf”</td>
<td>- TitleHouseOakSt.pdf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- AppraisalLot1234.pdf</td>
</tr>
</tbody>
</table>

3. Exit the **PDF Attachments** window.
Because you’ve indicated that a PDF file is attached, the program generates an EF Message regarding the attachment when the return is calculated.

To attach a PDF file to a return:

1. From the toolbar, click **View**. If anything was entered in the **PDF Attachments** window (see “Adding PDF Documents” on page 64), there will be two PDF–related items in the **View/Print** window:
   - An EF Message (item #1 in Figure 1-23 on page 65)
   - An **Attach PDF** button on the toolbar (item #2 in Figure 1-23 on page 65)

   ![Figure 1-23: The **MESSAGES** file (#1) and the **Attach PDF** button (#2)](image)

2. Click the **MESSAGES** file to view EF Messages, including information on how to attach the required documents to the return.
3. Click the **Attach PDF** button. The **EF PDF Attachments** window displays the information entered on the **PDF Attachments** window in data entry (Figure 1-24). A red X means the document has not yet been attached; a green check mark indicates an attached document.

   ![Figure 1-24: The **EF PDF Attachments** window](image)

4. Click the row of a document to attach.
5. Click **Browse**.
6. Find to the proper folder, select the PDF file to attach, and click **Open** (or double-click the file name).
Repeat for all documents with a red X. When all documents have been attached to a completed return, recalculate to clear the EF Message. The return is now ready to be e-filed.

**PRINTING GENERATED DOCUMENTS**

In some instances, Drake Tax generates a document that must be printed, signed, and scanned back into the computer to be attached to the return. For example, if Form 2553, Election by a Small Business Corporation, is present in an S corporation return (and the **Attaching Form 2553 as a PDF document** check box is marked on screen 1), EF Message 1513 is generated when the return is calculated.

513 ATTACH FORM 2553: The check box for "Attaching Form 2553 as a PDF document" on screen 1 has been marked, but no Form 2553 has been attached. Form 2553 must be prepared and attached before the return can be e-filed.

To prepare Form 2553 for attachment:

1. Click the "Form 2553" link on screen 1. (Screen 2553 is also available from the "Other Forms" tab of the Data Entry Menu.)
2. Ensure that the 2553 screen has been completed in data entry.
3. Calculate the return.
4. In View/Print mode, select and print all pages of Form 2553.
5. Have all shareholders sign the form.

To attach the signed Form 2553 to the return:

1. Scan the signed form and save it as a PDF document.
2. Go to View mode of the return.
3. Click the "Attach PDF" icon from the toolbar. The "EF PDF Attachments" window is opened.
4. Locate the PDF document on your computer and click "Open." The document's red "X" changes to a green check mark.
5. Click "Exit" to close the "EF PDF Attachments" window.
6. Recalculate the return to clear this message. The attachment process is complete when this message has cleared to attach scanned PDF to the return.

For detailed instructions on attaching this form to a return, go to the FAQ screen and click "Attaching Form 2553 as a PDF Document."

Figure 1-25: EF Message requiring PDF attachments

As shown in Figure 1-25, the EF Message states that attachments are required. You must print and then complete the statements, scan them into the computer, save them as PDF documents, and attach them to the return.

Some required PDF attachments—such as Schedule B-1—are generated by the program through data entry. These forms appear on the “EF PDF” page automatically and require no information be entered on the PDF screen. These attachments still must be “attached,” using the steps provided in “Attaching Documents to the Return” on page 65.
IMPORTING TRIAL BALANCE INFORMATION

Drake Tax’s trial balance import feature allows data to be imported into an 1120S return from a trial balance worksheet. The trial balance template and importing function has the following benefits:

• Eliminates the need to duplicate entries
• Reduces data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

NOTE

A flow chart of the trial balance importing process is available as an appendix at the end of this manual.

PREPARING TO USE TRIAL BALANCE IMPORT

The trial balance import function can be used only on returns that were created in Drake Tax 2008 or later. Like several other functions of the tax program, this feature requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax or update an existing client file from the prior year. Then create a trial balance worksheet. (See “Opening a Template” on page 69.)

Take the following steps to ensure the trial balance import works properly:

• **Activate Macros** — The trial balance import function uses macros in Microsoft Excel. Check your Excel settings to ensure that macros are activated and that macro settings are set to “Disable all macros with notification.” To do so:
  1. In the upper left corner of the worksheet, select File and then Options to open the Excel Options window.

In Excel 2007 and 2010 you may see a Security Warning message with an Options button. Click Options to open the Security Options dialog box, then select Enable this content. Click OK. (In Excel 2013, click Enable Content.)

In Excel 2007, click the Office button in the upper left and then click the Excel Options button at the bottom of the window. In Excel 2010 and 2013, click the File tab then select Options from the menu on the left.

2. From the menu on the left, select Trust Center, then, on the right side of the window, click the Trust Center Settings... button.
3. From the menu on the left, select Macro Settings.
4. Mark the option to Disable all macros with notification, then click OK. Save and close your worksheet.

• **Disable Autobalance in Drake Tax** — (optional) When autobalance is disabled, the program is prevented from automatically adjusting the year-end retained earnings or capital amounts, thus allowing you to see any discrepancies in the balance sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select Turn off autobalance (Figure 1-26).
• **Force Schedule L** — By default, Drake Tax does not display the balance sheet amounts on the return if the entity does not meet the filing requirement. If this is the case, you have to override the default setting in order to have the amounts shown on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT screen and select the **Force-print Schedules L and M-1** box (Figure 1-27 on page 68).

• **Check for Detail Worksheets** — The trial balance import allows only those detail worksheets required by the IRS. Check updated returns for detail (CTRL+W) worksheets that are not required. For example, the IRS does not require a detail worksheet for the **Gross receipts** field on the INC screen; if a return has a detail worksheet for that field, the trial balance will not be imported correctly into the return. Detail worksheets are indicated by red shading, as shown in Figure 1-28.

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” on page 70 for more information on using detail worksheets in the trial balance.
PREPARING FINANCIAL DATA FOR IMPORT

To prepare the financial data for importing into the return, the data must be entered into Drake Tax’s specially designed trial balance template. Once this information is entered and saved, it can be imported into the return.

Opening a Template

The first step in preparing financial data for importing is to open a trial balance template for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.
2. Click Import > Trial Balance Import from the menu toolbar. The preliminary Trial Balance Import dialog box is opened.
3. Click Create New or Open Existing. If opening an existing file, click Open after selecting the correct file.
4. If a Security Warning box appears, click Enable Macros.

NOTE

In Excel 2007 and 2010, you may see a Security Warning message with an Options button. Click Options to open the Security Options dialog box, then select Enable this content. Click OK. (In Excel 2013, click Enable Content.)

The trial balance template is displayed in Microsoft Excel.

File Location

Whenever a new template is opened, the tax program assigns it a default file location and name. Trial balance templates are saved in the “TB” folder of your Drake ’18 program.

To change the name of a file in Excel, open the worksheet, select File > Save As, and assign the new name.

NOTE

If saving a trial balance to a different location, make a note of where you store it. The program automatically looks in the default directory.

Template Structure

The trial balance template consists of three title rows and six columns. The Entity Name and Year End title rows can be edited; double-click a row to change the title. Columns are described in Table 1-4.

Table 1-4: Trial Balance Template Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Title</td>
<td>Title of account</td>
</tr>
<tr>
<td>Debit/Credit</td>
<td>Debit and credit amounts</td>
</tr>
<tr>
<td>Import to</td>
<td>Screen and line in Drake Tax to which the debit or credit amount is imported</td>
</tr>
<tr>
<td>Reported on</td>
<td>Location of the amount on the printed return</td>
</tr>
<tr>
<td>Other Information</td>
<td>Additional details for preparers; see “Details for Preparers” on page 73</td>
</tr>
</tbody>
</table>
Displayed at the bottom of the trial balance worksheet are the calculated amount for Schedule M-1, line 1; the credit and debit totals; a cell showing whether or not the balance sheet is out of balance and, if applicable, the out-of-balance amount (see Figure 1-29; see also Figure 1-32 on page 71).

Figure 1-29: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to assemble financial data for importing into data entry.

**ENTERING FINANCIAL DATA**

When a new trial balance file is opened for a return, all debit and credit amounts are zero ($0). All data must be entered manually into the template.

**NOTE**

Some data cannot be imported with the trial balance and must be entered directly into the data entry fields within the program. For more on these categories of data, see “Special Conditions” on page 73.

**Direct Entry**

Most cells in the trial balance worksheet are view-only. In a new template, editable debit and credit cells are indicated by a dollar amount ($0) and are not gray.

**Detail Worksheets**

Some cells require more detail than can be entered on a single line. These cells are indicated by buttons. (Figure 1-30) If these cells do not work, you may need to active them; see the Note in “Opening a Template” on page 69.

Figure 1-30: Example of cells that require worksheets
Click a worksheet button to open a worksheet in a new tab. Figure 1-31 on page 71 shows an example of the “Other Income” worksheet.

![Image of a trial balance worksheet for “Other Income”]

Figure 1-31: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the SBS TB tab (labeled “1” in Figure 1-31), or click the Click to return to TB button above the worksheet tabs (labeled “2” in Figure 1-31). Note that a detail tab (the “Other Income” tab in the lower left of Figure 1-31) might include one or more detail worksheets (labeled “3” in Figure 1-31).

**NOTE** Do not create detail worksheets in data entry of the tax software if the trial balance worksheet does not provide an equivalent detail worksheet or the trial balance will not be imported correctly.

**Totals**

Totals are displayed at the bottom of each worksheet. If credit and debit columns are out of balance, the worksheet highlights the out-of-balance amount (Figure 1-32).

![Image of totals in a worksheet]

Figure 1-32: Out-of-balance amount is highlighted if columns are out of balance.
In addition to credit and debit totals, the main trial balance worksheet shows the net income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjustments are made in the program.

**NOTE** The data cannot be imported if the worksheet is out of balance.

**SAVING A FILE**

To save a file, click the **Save** icon or select **File > Save** from the menu bar. (In Excel 2007 and 2010, click the **Office** button in the upper-left corner and select **Save**. In Excel 2013, click the **File** tab then **Save**.) To re-name a file when saving, select **File > Save As**. Trial balance templates are saved in the “TB” folder of your Drake ’18 program.

**IMPORTING DATA INTO A RETURN**

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial balance information can be imported into the program and calculated into the return.

Not all trial balance data can be imported directly into a return. For information on program limitations, see “Special Conditions” on page 73.

**NOTES**

If you are already in the Trial Balance Import tool for the selected return, go to the **Trial Balance Import** window in Drake Tax and start at Step 3 of the following procedure.

To import a trial balance into a return:

1. Open the return into which you will import the trial balance information.
2. Click **Import > Trial Balance Import** from the menu toolbar. The preliminary **Trial Balance Import** dialog box is opened.
3. Click **Next**.
4. Enter or select the trial balance file to be imported. If necessary, click the button to the right of **1. Import File Name** (blue circle in Figure 1-33) to browse to the proper folder. By default, each trial balance file is an Excel (.xls) file showing the client name and ending in “TB” for trial balance, as shown in the example in Figure 1-33. (See “File Location” on page 69.)

![Figure 1-33: Selected file to import](image)

5. Select any desired **Trial Balance Additional Import Options**. (See “Additional Import Options” following this procedure.)
6. Click **Next** and wait for the import to be completed.
7. Click **Finish**.
The program returns to the **Data Entry Menu** for the open return. Note that all selected data from the trial balance worksheet has been imported into the return.

This can be seen both in the data entry screens and on the generated return.

**NOTE** If the program does not calculate the trial-balance information as expected, you can return to the trial balance worksheet, make adjustments, and import the worksheet again.

**Additional Import Options**

The program can import the following additional information when importing the trial balance data (select the items to import or click **Select All**):

- Buildings & other depreciable assets
- Accumulated depreciation
- Land
- Goodwill & other intangible assets
- Accumulated amortization
- 8825/Rent information
- Cost of goods sold depreciation

**SPECIAL CONDITIONS**

Some items cannot be entered into the trial balance worksheet and must be typed directly into data entry. Other items should be entered into the worksheet for balance purposes but are not imported to data entry; these must be entered separately and the calculated results compared to the trial balance worksheet.

**Details for Preparers**

Most items go directly to the location indicated in the program and on the return. For example, the amounts shown in Figure 1-34 go to Schedule L, line 1, column d in the program and are shown on page 4, Schedule L, line 1, column d, of the 1120S return.

![Figure 1-34: Indication of where an amount will go in Drake Tax and on the return](image)

The “Other Information” column in the trial balance worksheet indicates special conditions and additional information regarding certain rows. Table 1-5 describes the most common notes in this column.

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>not included in totals</td>
<td>The amount is required for importing purposes only but is not included in the totals shown on the trial balance.</td>
</tr>
<tr>
<td>does not carry</td>
<td>Information cannot be imported and must be entered on the appropriate screen in Drake Tax. Screen is specified in “Reported on” column.</td>
</tr>
</tbody>
</table>

Table 1-5: “Other Information” Column Notes
Importing Trial Balance Information

SCH2 Detail

A balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is required for an item marked “does not carry” on the trial balance.

To complete an SCH2 detail screen in data entry:

1. In Drake Tax, open the SCH2 screen in the return. The SCH2 screen is accessible from the General tab of the Data Entry Menu and through links on the L screen.
2. On the SCH2 screen, select from the Line Number drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts imported from the trial balance worksheet and the totals of the amounts entered on the SCH2 screen.

See “The SCH2 Screen” on page 47 for more details on using the SCH2 screen.

Depreciation

S corporation returns can have up to four components of total depreciation:

- COGS
- Real estate rental
- Rental other than real estate
• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate fields on the trial balance worksheet. Note that, for 1120S trial balances, rental expense detail worksheets are required for 8825 and RENT depreciation.

• Enter 8825 and RENT depreciation amounts in the detail worksheets for importing purposes, but be aware that the 8825 and RENT screens in the program have to be edited if 4562 detail screens (see Figure 1-36) are used.

NOTES

• Accumulated depreciation is option for the Trial Balance Import.
• Depreciation expense entered in the Trial Balance Import will over-ride depreciation calculated by the tax program.

When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A of the return, and the rental depreciation expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, as applicable. Because the remaining depreciation can comprise any number of assets, the amount entered on the trial balance does not flow to the return. To ensure that each component of the total remaining depreciation is calculated into the return, each asset must be entered on the applicable depreciation screens in data entry (Figure 1-36).

Figure 1-36: Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation on the override screens (screens 6, 7, 8, and 9).

NOTE

Entering the remainder of the depreciation on the trial balance worksheet helps ensure that the balance sheet balances and provides a way to check that the amount on line 1 of Schedule M-1 is correct. Compare the calculated line 1 at the bottom of the trial balance to the equivalent line on Schedule M-1 of the calculated return. If the depreciation amounts match but the line 1 amounts differ, an M-1 adjustment could be required.

Rental Expenses

The following information applies only to S corporations with multiple rental properties.

The S corporation trial balances include lines for rental income and expenses (Figure 1-37 on page 76). Both rental expense items require a trial balance detail worksheet.
When imported, the rental expense data entered on the trial balance worksheet appears on either the **8825** screen (if real estate rental) or the **RENT** screen (if rental other than real estate).

Because the trial balance worksheet has only one detail screen per rental type, the importing function does not accommodate entities with multiple rental properties or expenses; however, the following procedure allows the trial balance to remain in balance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.
2. Enter the income totals on the trial balance sheet and the expense totals on the applicable detail sheets (Figure 1-37).
3. Ensure that the balance sheet is in balance.
4. Import the trial balance worksheet into the return. The applicable screens in data entry now contain the figures entered on the trial balance worksheet.
5. Enter the amounts on additional screens that require details. (For more information on data that cannot be imported, see “Special Conditions” on page 73.)
6. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on the calculated return to ensure that they match.

**NOTE** If the amounts do not match, review the imported amounts to ensure that all data was imported. If the data appears to have imported correctly, an M-1 adjustment could be necessary.

7. Complete all **8825** or **RENT** screens in data entry, as applicable, for the individual rental properties or items.
8. Delete the **8825** and **RENT** screens that were imported from the trial balance (the screens reflecting the total rental expenses).

**NOTE** To delete a screen in data entry, open the screen and press **CTRL+D**. If a multiple forms list appears, ensure that the screen to delete is selected, then click **Delete**.
FORM 3115, APPLICATION FOR CHANGE IN ACCOUNTING METHOD

Form 3115, Application for Change in Accounting Method, is an application to the IRS to change either an entity’s overall accounting method or the accounting treatment of any item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file.

Drake Tax customers can fill out and e-file Forms 3115 and related schedules and attachments for corporation returns.

NOTES

In some cases, Form 3115 must still be paper-filed. See IRS instructions for details.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for general automatic change procedures, and to Rev Proc. 2015-14 for a list of automatic changes to which the automatic change procedures in Rev. Proc. 2015-13 apply.

ACCESSING SCREENS FOR CHANGING ACCOUNTING METHOD

Several screens may be required for completing Form 3115. These screens are accessible from the Change in Accounting Method box, located under the Other Forms tab of the Data Entry Menu (Figure 1-38).

The screens accessible from the Change in Accounting Method section include:

- Screen 3115 (Change in Accounting Method) — Used to access fields for Form 3115, including Schedules A through D
- Screen 311E (Schedule E) — Used to request a change in depreciation or amortization methods
• Screen ATT (Explanations and Attachments) — Used to create and view certain attachments to be generated by the program

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete certain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six tabbed screens. As shown in Figure 1-39, you can access the various 3115 screens by clicking a tabbed link at the top of any of the 3115 screens.

![Figure 1-39: Tab links on 3115 screen](image)

**Multi-form Codes**

All 3115 and related screens contain a Multi-form code text box (shown in Figure 1-39) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new application you create in Drake Tax. The first should be “1,” the second “2,” and so on. When using other screens, such as the 311E or ATT screens, you can use those numbers to indicate which instance of Form 3115 the 311E or ATT screen should be associated with.

**NOTE**

If only one Form 3115 is being submitted, you do not need to enter anything in the Multi-form code box.

**TIP**

See Screen Help of screen 3115 to access links to the Form 3115 instructions through the IRS website. (Available from the right-click menu, from the data-entry toolbar when screen 3115, Part I tab is open, or by pressing CTRL+ALT+?.)

**Notices of Missing Attachments**

In addition to Form 3115 and related schedules and statements, the program produces EF Messages (as applicable) when the return is calculated. All forms, schedules, EF messages, and worksheets are accessible from View mode.

EF Messages for Form 3115 provide information about required attachments (including PDF attachments) that are missing from the return. Some EF Messages list all statements required for a particular section but do not indicate which statements, specifically, are missing. To best understand which attachments are still required, compare the ATT screen and the EF PDF worksheet to the list on the EF Message.

**NOTE**

All EF Messages must be eliminated before the return is eligible for e-file. EF Messages for Form 3115 attachments are eliminated when all required statements have been attached to the return.
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporation tax return from a trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the following benefits:

• Eliminates the need to duplicate entries
• Eliminates data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
Trial Balance Import: General Process

**Prepare to use Trial Balance Import**
- Activate Excel macros
- Disable autobalance
- Force Schedule L
- Delete unnecessary detail worksheets

**Trial Balance Template**
(Import > Trial Balance Import)
- Direct entry data (cells with $0)
- Applicable detail worksheets
- Totals for:
  - Depreciation
  - Schedule L
  - Rentals (1120S & 1065 only)

**Data Entry**
Enter any trial balance data that cannot be imported via Trial Balance Import
- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets (depreciation)

**Compare M-1, line 1: Does trial balance match Schedule M-1, line 1?**
- Yes
  - 1120 return?
    - Yes
      - Go to data entry an enter individual rentals on 8825 or RENT screens as applicable
    - No
      - Delete imported 8825 and RENT screens
  - No
    - 110S & 1065: Were rental totals entered in trial balance?
      - Yes
        -过程完成!
      - No
        - Make M-1 adjustment

**Did data import correctly?**
- Yes
  - Is an M-1 adjustment necessary?
    - Yes
      - Adjust amounts elsewhere in data entry
    - No
      - Make M-1 adjustment
- No
  - Make corrections in TB worksheet

**990, 990-EZ, or 990-PF return?**
- No
  - Process complete!
Index

Numerics
52-53-week year returns 60

A
accounting method
  changing 77–78
  entering 14
accumulated adjustments account (Schedule M-2) 51, 52
address
  change of 14
  e-mail 28
  entering on Form 1120S 12
  foreign 41
  on K-1 letter heading 44
  out-of-state 12
adjusted basis worksheet 45, 59
adjustments
  credit 16
  depreciation 49
  section 481 16
  to income and expenses 56
advertising expenses 20
Aggregation 35
  multiple 36
amended
  1120S returns 14, 26
  K-1 letters 45
amortization 21, 47
analysis of accounts (Schedule M-2) 51–53
APPT screen, see Multi-State apportionment
asterisks (on K-1 codes) 41
attachments
  binary (PDF) 63–66
  Form 8825 statements 56
  to Form 3115 77
autobalance 48

B
bad debts 16, 18
basis 45–46
  see also adjusted basis worksheet
binary (PDF) attachments 11, 63
books
  in care of 18
book-to-tax differences (Schedule M-1) 49
Business Activities Statement 37
business activity codes 14
Business Aggregation Number 35
  PBAN 35

C
calendar-year returns 13
change file type 11
Change in Accounting Method 77–78
change of name or address 14
charitable contributions 32
Client Communications Editor (for letters) 44
codes
  business activity 14
  K-1 40, 59
  miscellaneous (screen 1) 12
  multi-form 54, 78
  state 28
compensation of officers 17
compensation of shareholders 16
contact information (for state returns) 28
cost of goods sold, see Schedule A (Cost of Goods Sold)
cover letters (K-1) 44
coversheets 59
credit adjustments 16
credits 56
Ctrl+W (detail) worksheets 14, 15, 68

data entry
  for state information 27
  importing trial balance into 67–76
dates
  of incorporation 14
  payment (changing) 24
tax year 13
decrease to basis 45
deductions 16–21
QBI 32
depletion 20
oil and gas 36
depreciation 15
  and auto-balance errors 48
  expense 19
  for cost of goods sold (Schedule A) 15
  of rentals 53
on short-year returns 13
printing Form 4562 58
trial balance (business returns only) 74
detail (Ctrl+W) worksheets 14, 15, 68
direct debit of balance due 24–25
direct deposit of refunds 23
distributions 51
Doing Business As 12
domestic production activities deduction 43
due dates 24

E
EF_ACK page 60
e-filing
Form 1120S 60
PDF attachments 63–66
statements 47
Elections
Safe Harbor 58
elections 56
statements 58
electronic
funds withdrawal 24–25
signatures (PIN) 26
Employee benefits programs 20
employer identification number (EIN) 14
envelope coversheets 59
error codes 62
estimates
previous-year tax 22
underpayment of 23
expenses 16–21
exporting K-1 data 42
extensions 25

F
Family Medical Act credit 10
filing instructions 59
final return 14
first year returns 13
fiscal year returns 13
foreign
addresses for shareholders 41
transactions 24
Foreign Transaction Statement 31
Form 1125E 58
Form 2553 (Election by a Small Business Corporation) 11, 14
Form 3115 (Application for Change in Accounting Method) 77–78
Form 4136 (Credit for Federal Tax Paid on Fuels) 23
Form 4562 (Depreciation and Amortization) 54, 58
Form 4797 (Sales of Business Property) 15
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit) 16
Form 7004 (Application for Automatic Extension of Time to File) 25
Form 8050 (Direct Deposit of Corporate Tax Refund) 23
Form 8825 (Rental Real Estate Income and Expenses of a Partnership or an S Corporation) 53–56
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) 19
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit) 16
Form 8873 (Extraterritorial Income Exclusion) 21
Form 8903 (Domestic Production Activities Deduction) 43
Form 8916-A (Supplemental Attachment to Schedule M-3) 50
Form 8941 (Credit for Small Employer Health-Insurance Premiums) 21
Form 8990, Limitation on Business Interest Expense Under Section 163(j) 10
Form 8994, Employer Credit for Paid Family and Medical Leave 10
Form 965, Inclusion of Deferred Foreign Income Upon Transition to Participation Exemption System 10
Form T (Forest Activities Schedules) 20

G
gains and losses 15
GILTI 10
Global Intangible Low-Taxed Income 10
gross receipts 14

H
header information 12

I
import, trial balance 67–76
In care of 12
inactive returns 58, 61
income 14–16
increase to basis 45
instructions for filing 59
insurance proceeds, income from 16
interest
expense 19
income 16
inventory 15

K
K-1
codes 40
export 42
Schedule for 1120S 37–46
K1 overrides 39

L
labor 16
letters (K-1) 43

M
maintenance costs 18
Multi-State Apportionment 28

N
name and address
corporation 12
shareholder 38
name change 14
net operating losses (NOL) 53
next-year depreciation listing 58
number of shareholders 14

O
officer compensation 17
oil and gas depletion 36
ordinary gains and losses 15
other
adjustments account 53
costs (Schedule A) 15
deductions 21
expenses 54
income (loss) 16
ownership
changes 40
percentages 18
Ownership and participation 18

P
passive income 21
PBAN 35
PDF (binary) attachments 11, 63–66
pension and prior sharing 20
percentage, stock and ownership 18
PIN (electronic) signatures 26
printing
cover letter for K-1 44
K-1 items 41
line 22a worksheet 21
statements for Schedule L 47
suppressing/forcing documents 58

Q
QBI
aggregations 35
QBI deduction 32
Qualified Business Income 32
Qualified Opportunity Funds 9

R
real estate 74
receipts 14
reconciliation
Schedule L and M-2 46
Schedules M-1, M-3 49
references to forms and worksheets 59
refunds
direct deposit of 23
state tax 16
rent paid on business property 18
rental activities 53–56
Rental properties
safe harbor 34
repair costs 18
retained earnings reconciliation (worksheet) 59
returns
52-53-week year 60
amended 26
bankruptcy 60
extensions for 22, 25
fiscal and calendar year 13
inactive 61
short-year 13
signing 26
tax-exempt organizations (990) 63–66
updating prior-year 11
revocation of S election 14
rounding shareholder 38

S
S corporation
changing to 11
electing as 11
termination of 14
Safe Harbor 34, 58
Safe Harbor Elections 58
scanning (PDFs for e-filing) 63
SCH2 screen (for Schedule L) 47
Schedule B (Other Information) 27
Schedule D (Capital Gains and Losses and Built-In Gains)
Parts I, III, and III 21
Schedule K (Shareholders’ Pro Rata Share Items) 30–32
Schedule K-1
supplemental information 42
Schedule K-1 (Share of Income, Deductions, Credits, etc.)
  sorting business K-1s 39
  viewing business K-1s 39
Schedule K-1 (Shareholder Information) 37–46
Schedule L 58
Schedule L (Balance Sheet per Books) 46–49
Schedule M-1 49, 58
Schedule M-2 51–53
Schedule M-3 50
section
  481 adjustments 16
Section 199A items 34
security
  business packages 59
  security screen 59
Service trade or business 33
shareholders
  adjusted basis worksheet 45–46
  compensation of 16
  foreign addresses for 41
  multiple 41
  number of 14
  rounding 38
  Schedule K-1 37
  updating data annually 45
short-year return 13
short-year returns 13
signatures, electronic 26
signs return 18, 37
SSTB 33
state
  address 12
  codes 28
  -specific information 27
  tax refunds 16, 24
statements
  elections 58

T
  tax
    and payments 21–23
    on fuels, credit for 16
    returns, see returns
    years (fiscal vs calendar) 13
  taxes and licenses 19
termination of S election 14
trial balance import
  and depreciation 15
  and Schedule L 46, 48
  instructions for using 67–76

U
  underpayment of estimated tax 23
  undistributed taxable income previously taxed 53
  updating
    an 1120S return 11
    shareholder data annually 45
V
  vouchers 22
W
  wages 16
Y
  Year screen 13